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М54  Методичні рекомендації до виконання лабораторних робіт  

з навчальної дисципліни "Ілюстрування" для студентів напряму під-

готовки 6.051501 "Видавничо-поліграфічна справа" всіх форм на-

вчання / укл. Т. Ю. Андрющенко. – Х. : Вид. ХНЕУ ім. С. Кузнеця, 

2014. – 160 с. (Укр. мов.) 

 

Подано основні рекомендації до лабораторних робіт з ілюстрування. Наведено 

порядок виконання лабораторних робіт, проаналізовано основний навчальний мате-

ріал, запропоновано структуру матеріалу, який необхідно включати у звіт. 

Рекомендовано для студентів напряму підготовки 6.051501 "Видавничо-полі-

графічна справа" всіх форм навчання. 
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Вступ 

 

Навчальна дисципліна "Ілюстрування" вивчається студентами на-

пряму підготовки 6.051501 "Видавничо-поліграфічна справа" усіх форм 

навчання протягом третього семестру і є методологічною і методичною 

основою для опанування студентами предметної області створення ілю-

страцій для друкованих та електронних видань. 

Навчальна дисципліна належить до групи вибіркових дисциплін  

і забезпечує підготовку студентів до майбутньої професійної діяльності  

в умовах сучасного розвитку друкованих та електронних видань. Подаль-

ший розвиток ідеї набувають у дисциплінах "Основи композиції та дизайну", 

"Видавнича справа та технічне редагування" тощо. Навчальна дисципліна 

забезпечує підготовку студентів до майбутньої професійної діяльності  

в умовах розвитку друкованих та електронних видань. Навчальна дис-

ципліна готує студентів до вивчення взаємопов’язаних професійно-орієн-

тованих і спеціальних питань друкованих та електронних видань, до вико-

ристання отриманих знань при підготовці курсових, кваліфікаційних робіт, 

дипломних проектів, при розв’язанні практичних задач. 

Метою викладання навчальної дисципліни є:  

надання студентам необхідних знань щодо технік створення ілюст-

рацій; 

надання студентам необхідних знань щодо методик створення ілю-

страцій; 

надання студентам необхідних знань щодо стилів створення ілюст-

рацій; 

викладення студентам знань про властивості матеріалів та інстру-

ментів створення ілюстративного матеріалу; 

формування у студентів комплексу знань та вмінь, які допоможуть 

їм в майбутньому самостійно створювати високоякісні ілюстрації; 

вивчення можливостей і отримання практичних навичок з викорис-

тання комп’ютерної техніки для створення скетчів; 

вивчення можливостей і отримання практичних навичок з викорис-

тання комп’ютерної техніки для створення колажів; 

вивчення можливостей і отримання практичних навичок з викорис-

тання комп’ютерної техніки для створення цифрових ілюстрацій. 



4 

Завдання навчальної дисципліни  оволодіння навичками ство-

рення ілюстрацій для різних видів друкованих видань, обрання колірної 

гами видання та створення цифрових ілюстрацій. 

Предмет навчальної дисципліни – техніки створення класичних 

та цифрових ілюстрацій; способи використання інструментів і матеріалів 

для створення класичних ілюстрацій; програмне та апаратне забезпе-

чення для створення цифрових ілюстрацій; методика створення ілюст-

рацій, що забезпечують навчальний процес. 

Саме тому вивчення дисципліни є доцільним для студентів напряму 

підготовки 6.051501 "Видавничо-поліграфічна справа" усіх форм навчання. 

Запропоновані методичні рекомендації надають можливість ство-

рювати ілюстрації різних стилів та напрямків ілюстрування, а також  

надають можливість опанувати різні інструменти та матеріали для ство-

рення ілюстрацій та допомагають студенту сконцентруватися на голов-

них аспектах виконання лабораторних робіт. 
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Змістовий модуль 1. Класичне 

ілюстрування 

 

Лабораторна робота № 1 

Тема "Знайомство із сучасною ілюстрацією" 

 

Мета роботи – ознайомитися з біографією і роботами відомих су-

часних вітчизняних і закордонних художників-ілюстраторів; проаналізува-

ти підходи до ілюстрування відомих художніх творів. 

Дана лабораторна робота сприяє напрацюванню наступних компе-

тентностей у відповідності до Національної рамки кваліфікації: 

Знання: 

загальні відомості про ілюстрування; 

призначення ілюстрацій; 

поняття про види ілюстрацій. Робоче місце ілюстратора; 

поняття стилю ілюстрування. Ознаки стилю в роботах відомих ілю-

страторів; 

жанри в ілюстрації. Напрями живопису. 

Уміння: 

вибирати і застосовувати ілюстрації на етапі додрукарської підго-

товки для різних видів видань; 

вибирати і застосовувати різні стилі в ілюструванні різних видів видань; 

вибирати і застосовувати різні жанри та напрями в ілюструванні різ-

них видів видань. 

Комунікації: 

аргументована взаємодія з авторами при виборі стилю ілюстрування 

різних видів видань; 

аргументована взаємодія з авторами при виборі жанру та напряму 

ілюстрування різних видів видань; 

активна участь в команді учасників додрукарської підготовки з про-

позиціями щодо розміщення ілюстрацій за їх видами; 

аргументована взаємодія з авторами при формуванні змісту ілюст-

рування. 

Автономність і відповідальність: 

пошук сучасніших жанрів в ілюструванні; 
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точний прогноз результатів ілюстрування при створенні різних видів 

видань; 

професійна підготовка фахівців додрукарської підготовки; 

вибір іншого стилю ілюстрування при незадовільному результаті. 

 

Хід роботи 

 

1. Підготувати презентацію, присвячену біографії та творчості одно-

го із художників-ілюстраторів, які перераховані нижче: 

1. Лев Каплан. 

2. Ганна Русакова. 

3. Жан-Батіст Монг (Jean-Baptiste Monge). 

4. Ніколєтта Чіччоллі (Nicoletta Ceccoli). 

5. Генадій Спірін. 

6. Роб Скоттон (Rob Scotton). 

7. Філ Дунський. 

8. Андрій та Ольга Дугини. 

9. Віктор Чіжиков. 

10. Джей Скотт Кемпбелл (Jeffrey Scott Campbell). 

11. Йоша Зауер (Joscha Sauer). 

12. Ральф Руте (Ralph Ruthe). 

13. Хіхус (он же Павел Сухих). 

14. Шу Мізогучи (Shu Mizoguchi). 

15. Ганна Ігнат’єва. 

16. Кім Хаскінс (Kim Haskins). 

17. Cristina Bellacicco. 

18. Shin Jae Won. 

19. Трістан Елвелл (Tristan Elwell). 

20. Владислав Єрко. 

21. Кирил Челушкин. 

22. Марсель Ніно Пажо (Marcel Nino Pajot). 

 

Презентація повинна містити: 

а) біографію ілюстратора та його фото; 

б) опис характерних рис ілюстрацій (сюжет, основні колірні тони, 

настрій, характерні графічні елементи і т. д.); 
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в) опис техніки творення ілюстрацій (цифрова, акварельна, олівець 

і т. д.); 

г) фотографію робочого місця ілюстратора; 

д) спосіб організації портфоліо (банк зображень, веб-сайт, веб-га-

лерея і т. д.) з веб-сторінок; 

е) приклади робіт (не менше 10). 

Оформлення презентації повинно узгоджуватися зі стилем обрано-

го ілюстратора. 

 

2. Підготувати презентацію з аналізом ілюстрацій, які створені різ-

ними авторами, для одного з літературно-художніх творів, наведених 

нижче: 

1. Мігель де Сервантес "Дон Кіхот". 

2. Льюїс Керролл "Аліса в країні чудес". 

3. Льюїс Керролл "Аліса в задзеркаллі". 

4. Антуан де Сент-Екзюпері "Маленький принц". 

5. Ганс Християн Андерсен "Дюймовочка". 

6. Ганс Християн Андерсен "Снігова королева". 

7. Рудольф Еріх Распе "Пригоди барона Мюнхаузена". 

8. Шарль Перро "Попелюшка". 

9. Лаймен Френк "Чарівник країни Оз". 

10. Ернст Теодор Амадей Гофман "Лускунчик і мишачий король". 

11. Астрід Ліндгрен "Пеппі Довга панчоха". 

12. Ганс Християн Андерсен "Гидке каченя". 

13. Микола Васильович Гоголь "Ніч перед Різдвом". 

14. Микола Васильович Гоголь "Тарас Бульба". 

15. Микола Васильович Гоголь "Вій". 

16. Антон Павлович Чехов "Каштанка". 

17. Олександр Дюма "Три мушкетери". 

18. Олександр Сергійович Пушкін "Казка про царя Салтана". 

19. Олександр Сергійович Пушкін "Казка про золоту рибку". 

20. Вірші Данила Хармса. 

21. Вірші Юнни Моріц. 

22. Михайло Афанасійович Булгаков "Майстер і Маргарита". 

23. Вільям Шекспір "Ромео і Джульєтта". 

24. Російська народна казка "Колобок". 

25. Російська народна казка "Ріпка". 
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Презентація повинна містити приклади обкладинок і внутрішніх 

сторінок з ілюстраціями обраного твору (із зазначенням імені та прізвища 

ілюстратора для кожної серії ілюстрацій), а також підсумковий розділ, що 

описує: а) загальні риси всіх ілюстрацій; б) відмінності, пов’язані зі сти-

лем того або іншого ілюстратора; в) найбільш незвичайний підхід до ілю-

стрування твору; г) ілюстрації, які найбільше сподобалися.  

 

 

Лабораторна робота № 2 

Тема "Техніка монотипії" 

 

Мета роботи – навчитися створювати ілюстрації для обраного лі-

тературно-художнього твору в техніці монотипії, а також вивчити власти-

вості акварельної та акрилової фарби як матеріалів для створення ілюс-

трацій. 

Дана лабораторна робота сприяє напрацюванню наступних компе-

тентностей у відповідності до Національної рамки кваліфікації: 

Знання: 

інструменти та матеріали для створення ілюстрацій; 

особливості техніки створення ілюстрацій; 

допоміжні добавки для покращення властивостей фарби; 

властивості фарб, інструментів, паперу для технік малювання; 

особливості пензлів для малювання, їх види та властивості; 

особливості гумок для стирання, їх види та властивості; 

нестандартні техніки ілюстрування. 

Уміння: 

вибирати і застосовувати інструменти та матеріали для створення 

ілюстрацій; 

вибирати і застосовувати техніки створення ілюстрацій; 

використовувати властивості фарб, інструментів та паперу для тех-

нік малювання; 

вибирати і застосовувати нестандартні техніки створення ілюстрацій. 

Комунікації: 

аргументована взаємодія з авторами при виборі матеріалів для 

створення ілюстрацій; 

аргументована взаємодія з авторами при виборі технік для ство-

рення ілюстрацій; 
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уточнення характеристики пристроїв і машин, на яких планується 

друкувати тираж. 

Автономність і відповідальність: 

пошук сучасніших інструментів в ілюструванні; 

вибір іншої техніки ілюстрування при незадовільному результаті. 

 

Хід роботи 

 

1. Монотипія (від "моно" – один і грец. "типос" – відбиток, дотик, 

образ, "один відбиток") – нетрадиційна техніка малювання, метою якої  

є отримання відбитків. Кожен відбиток неповторний і унікальний, так як  

у створенні монотипії досить велику роль відіграє фактор випадковості. 

Існує безліч різних технік монотипії, найпростіша з яких – нанести 

на папір або скло будь-яке зображення, а потім накрити зверху листом 

паперу і щільно притиснути. На верхньому аркуші вийде шуканий відби-

ток. 

Плюси монотипії полягають в тому, що для її виготовлення не по-

трібно мати професійних навичок малювання. 

2. Підготовка матеріалів для монотипії. 

Для виготовлення монотипії на склі знадобиться: крейдований (глян-

совий, слизький на дотик) папір, великий круглий пензель, скло, акварель 

або акрил, вода. Папір і скло можуть бути будь-якого розміру, але для 

зручності часто використовують формат А4. Папір також може бути  

і простий, але в такому випадку ефект вийде іншим. Акварельний папір 

для монотипій використовують рідко, проте в даній лабораторній роботі 

необхідно перевірити властивості і поведінку фарб на різному папері, 

тому монотипії буду створюватися і на акварельному папері (у випадку  

з акрилом ще й на картоні), і на крейдованому. 

3. Створення монотипії. 

Процес створення монотипії складається з декількох етапів: 

а) нанесіть фарбу на скло. Чим щільніше нанесена фарба, тим ці-

кавіше вийде результат, тому він не повинен містити дуже велику кіль-

кість пробільних елементів. У випадку з акрилом фарбу необхідно нанести 

на пластиковий файл, який після завершення роботи можна буде вики-

нути, так як у разі роботи зі скляною поверхнею її буде дуже складно 

очистити від фарби; 
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б) накрийте скло з фарбою аркушем паперу, щільно притисніть, 

проводячи рукою зверху вниз. Потім дуже акуратно, щоб не потекла ак-

варель, переверніть скло з папером склом вгору; 

в) різко, але маленькими шматочками, починайте відривати скло 

від паперу, тримаючи його за верхній кут. 

Для створення ефекту "хвиль" постійно відривайте і знову накла-

дайте скло на папір, щоразу зрушуючи нижче на пару сантиметрів. Також 

у процесі можуть з’являтися різні "водорості" і цікаві патьоки. Процес по-

вністю контролюється; якщо не сподобалося якесь місце, на нього знову 

накладається скло, й ілюстрація видозмінюється. 

г) розгляньте результат. Можна накласти скло з фарбою на не за-

фарбовані місця ще раз, додати ефектів. При бажанні також можна до-

малювати монотипію вручну, щоб довести до якого-небудь конкретного 

образу. Результати створення монотипій подана на рис. 2.1 та рис. 2.2. 

 

 

 

Рис. 2.1. Результат створення монотипії 
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Рис. 2.2. Результат створення монотипії 

 

Можливі помилки при створенні монотипії: 

1. Не забувайте про те, що отриманий відбиток буде дзеркальним 

відображенням малюнка на склі; 

2. Зовнішній вигляд відбитка залежить від тиску і від властивості 

фарб. Якщо фарба густа, то при сильному натисканні плями будуть мати 

великий діаметр, тому або мазки фарби повинні бути тонкими, або на-

тиснення несильним; 

3. Швидкість створення акрилових монотипій повинна бути висо-

кою, тому що фарба дуже швидко засихає на поверхні; 

4. Білила в монотипії традиційно не застосовуються, як і в акварелі. 

Білі місця виходять за рахунок видалення барвистого шару. Однак, якщо 

папір має колір, відмінний від білого, можна робити нюанси білого кольору; 

5. На скляну поверхню не завжди наносяться тільки хаотичні плями. 

Також можна створювати осмислені композиції, проте не слід забувати, 

що можна перестаратися і надати монотипії "штучний" вигляд. 

 

Завдання 

1. Створіть монотипії: 

а) аквареллю на акварельного папері; 

б) аквареллю на крейдованому папері; 

в) акрилом на картоні; 

г) акрилом на крейдованому папері. 
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У звіт вставте відскановані результати, порівняйте їх. Опишіть по-

ведінку кожної з фарб на кожному з паперових носіїв. Опишіть, який ре-

зультат вам найбільше сподобався і чому, і який результат виявився 

найпрактичнішим (фарба не змащується з паперовою поверхнею, не об-

сипається, не липне і т. д.). 

2. Виберіть літературно-художній твір і створіть три ілюстрації в те-

хніці монотипії за допомогою матеріалів на ваш вибір. Доопрацювати 

монотипії будь-яким зручним способом (можна обвести контури гелевою 

ручкою, доопрацювати деякі ділянки ілюстрації фарбою або олівцями).  

У звіт вставте відскановані ілюстрації з описом об’єктів або подій, які на 

них зображені. Можна вставити фрагменти тексту, яким відповідають 

отримані ілюстрації. 

Звіти здаються в паперовому та електронному варіантах. Вихідні 

результати, отримані в результаті виконання лабораторної роботи, збері-

гаються в спеціальній індивідуальної папці (пластиковий швидкозшивач  

з файлами) і здаються в кінці кожної роботи. 

 

 

Лабораторна робота № 3 

Тема "Техніка малювання аквареллю" 

 

Мета роботи – навчитися використовувати техніку роботи акварел-

лю для створення ілюстрацій, освоїти роботу з акварельними фарбами, 

акварельними олівцями, акварельним папером. 

Дана лабораторна робота сприяє напрацюванню наступних компе-

тентностей у відповідності до Національної рамки кваліфікації: 

Знання: 

інструменти та матеріали для створення ілюстрацій; 

особливості техніки створення ілюстрацій; 

допоміжні добавки для покращення властивостей фарби; 

властивості фарб, інструментів, паперу для технік малювання; 

особливості пензлів для малювання, їх види та властивості; 

особливості гумок для стирання, їх види та властивості; 

нестандартні техніки ілюстрування. 
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Уміння: 

вибирати і застосовувати інструменти та матеріали для створення 

ілюстрацій; 

вибирати і застосовувати техніки створення ілюстрацій; 

використовувати властивості фарб, інструментів та паперу для тех-

нік малювання; 

вибирати і застосовувати нестандартні техніки створення ілюстрацій. 

Комунікації: 

аргументована взаємодія з авторами при виборі матеріалів для 

створення ілюстрацій; 

аргументована взаємодія з авторами при виборі технік для ство-

рення ілюстрацій; 

уточнити характеристики пристроїв і машин, на яких планується 

друкувати тираж. 

Автономність і відповідальність: 

пошук сучасніших інструментів в ілюструванні; 

вибір іншої техніки ілюстрування при незадовільному результаті. 

 

Хід роботи 

 

1. Малюванням акварельними фарбами. 

Перед малюванням акварельними фарбами необхідно приготувати 

дві склянки води (один для полоскання пензля, інший для змочування 

паперу); паперовий рушник для витирання зайвої фарби з пензля; палітру, 

на якій підбирають необхідні кольори перш, ніж розфарбовувати малю-

нок; акварельний папір (270 – 300 г/м2).  

Перед початком малювання необхідно нанести малюнок на аква-

рельний папір простим олівцем і потім змочити папір водою за допомо-

гою товстої пензля. 

Якщо малювати фарбою на мокрому папері, то виходять м’які "пере-

ходи" з кольору в колір. Фрагмент "невдалого місця" можна змити водою, 

знімаючи надлишок сухим пензлем або губкою. 

Оптимально тримати під рукою два-три пензлі. Номери пензлів – 2, 

4 і 8 (або 10). Номери 2 і 4 – для малювання дрібних деталей, номери 8 

або 10 – для заливки великих площин. Пензлі повинні бути загострені, 

коли вони наповнені водою або фарбою. Тонку лінію можна провести, 

якщо тримати пензель вертикально, широку – якщо тримати пензель по-
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хило. Для того, щоб розфарбувати малюнки аквареллю, необхідно вико-

нати наступні дії: 

1. Готовий ескіз переведіть на папір за допомогою світлового столу 

або віконного скла (рис. 3.1). 

 

 
 

Рис. 3.1. Ескіз, перенесений на акварельний папір, автор К. Овчарова  

 

2. Рясно змочіть папір водою і дайте їй вбратися в папір. 

3. Підготуйте в палітрі фарби для фону шляхом змішування і роз-

ведення фарб водою. При змішуванні фарб – не більше двох-трьох – 

отримують нові кольори і відтінки. Додаючи в акварель воду, отримуємо 

більш світлий тон. 

4. Нанесіть фонові плями на ескіз (рис. 3.2) великим пензлем.  

 

 
 

Рис. 3.2. Фонові плями на ескізі, автор К. Овчарова  
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5. Пропрацюйте деталі зображення більш дрібними пензлями, як 

подано на рис. 3.3, рис. 3.4 та рис. 3.5, попередньо змочуючи чистою во-

дою ту ділянку, яку будете розфарбовувати для отримання більш плав-

них переходів. Не натискайте на пензель так, щоб ворс розсипався в усі 

сторони, кінчик повинен залишатися гострим. 

 

 
 

Рис. 3.3. Опрацювання деталей малюнка, автор К. Овчарова  

 

Опрацюйте деталі зображення дрібними пензлями, як подано на 

рис. 3.4. 

 

 
 

Рис. 3.4. Опрацювання деталей малюнка, автор К. Овчарова  

 

Опрацюйте деталі зображення дрібними пензлями, як подано на 

рис. 3.5. 
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Рис. 3.5. Опрацювання деталей малюнка, автор К. Овчарова  

 

Корисні поради: 

використовуйте невеликі пензлі, особливо, якщо ви хочете, щоб на 

зображенні було багато деталей; 

намагайтеся не проводити пензлем кілька разів в одному місці – 

зображення вийде "мутним"; 

використовуйте ескіз зображення і кольорів; 

намагайтеся, щоб на малюнку не було ізольованих об’єктів. З’єд-

найте найбільші об’єкти за допомогою тіней – зображення буде вигляда-

ти більш природньо; 

червоний і блакитний кольори витирати найважче – додайте трохи 

білого, щоб полегшити собі завдання; 

якщо ви хочете, щоб якась ділянка була дійсно білою – не наносить 

на неї фарбу. Якщо ділянка маленька, і її складно не зачепити, захистіть 

її "латкою" з парафіну, а потім акуратно зніміть її лезом. 

Приклади ескізів і готових ілюстрацій показані на рис. 3.6. 
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Рис. 3.6. Приклади ескізів і готових ілюстрацій в акварельній техніці 

 

2. Малювання акварельними олівцями. 

Робота з акварельними олівцями схожа на роботу зі звичайними 

кольоровими олівцями, за винятком того, що зафарбовані частини мож-

на розмити водою (тому при малюванні не потрібно дотримуватися пра-

вил штрихування). 

Існують суха (не потрібно попередньо змочувати папір водою) і мок-

ра (потрібно попередньо змочити папір) техніки малювання акварельни-

ми олівцями. У даній лабораторній роботі буде використовуватися суха 

техніка. 

Для того, щоб отримати кольорове зображення, необхідно ескіз 

спочатку розфарбувати акварельними олівцями (рис. 3.7), а потім окремі 

ділянки малюнка розмити водою (рис. 3.8). 
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Рис. 3.7. Початкове зображення, автор К. Овчарова  

 

 
 

Рис. 3.8. Зображення з розмитими ділянками, автор К. Овчарова  
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Завдання 

1. Виберіть вихідне зображення з папки, зазначеної викладачем, і 

за допомогою світлового столу або віконного скла зробіть ескіз на зви-

чайному або тонкому акварельному папері. 

2. Грубими мазками акварельної фарби (попередньо НЕ змочуючи 

папір) визначте основні кольори майбутньої ілюстрації на ескізі. 

3. За допомогою світлового столу або віконного скла перенесіть 

малюнок на щільний акварельний папір (необхідно зробити дві копії). 

4. Розфарбуйте малюнок аквареллю (попередньо змочивши аркуш 

паперу). 

5. Розфарбуйте малюнок акварельними олівцями (папір поперед-

ньо змочувати не потрібно). 

6. Проаналізуйте результати. Опишіть, у якій техніці вам найбільше 

сподобалося працювати та чому. 

7. У звіт необхідно помістити: 

а) вихідне зображення; 

б) ескіз з попередньо вибраними кольорами; 

в) готову ілюстрацію, виконану акварельними фарбами; 

г) готову ілюстрацію, виконану акварельними олівцями; 

д) висновки (див. п. 6 завдання). 

 

 

Лабораторна робота № 4 

Тема "Техніка малювання пастеллю" 

 

Мета роботи – освоїти техніку створення ілюстрацій олійною пас-

теллю. 

Дана лабораторна робота сприяє напрацюванню наступних компе-

тентностей у відповідності до Національної рамки кваліфікації: 

Знання: 

інструменти та матеріали для створення ілюстрацій; 

особливості техніки створення ілюстрацій; 

допоміжні добавки для покращення властивостей фарби; 

властивості фарб, інструментів, паперу для технік малювання; 

особливості пензлів для малювання, їх види та властивості; 

особливості гумок для стирання, їх види та властивості; 

нестандартні техніки ілюстрування. 
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Уміння: 

вибирати і застосовувати інструменти та матеріали для створення 

ілюстрацій; 

вибирати і застосовувати техніки створення ілюстрацій; 

використовувати властивості фарб, інструментів та паперу для тех-

нік малювання; 

вибирати і застосовувати нестандартні техніки створення ілюстрацій. 

Комунікації: 

аргументована взаємодія з авторами при виборі матеріалів для 

створення ілюстрацій; 

аргументована взаємодія з авторами при виборі технік для ство-

рення ілюстрацій; 

уточнити характеристики пристроїв і машин, на яких планується 

друкувати тираж. 

Автономність і відповідальність: 

пошук сучасніших інструментів в ілюструванні; 

вибір іншої техніки ілюстрування при незадовільному результаті. 

 

Хід роботи 

 

Пастель (фр. пастель, від лат. макаронні вироби – тісто; "сухий жи-

вопис") – м’яка кольорова крейда, яка виготовляється з пігментів, крейди 

і сполучних елементів. 

Пастель використовується як для живопису, так і для малюнка. Тех-

ніка пастелі найбільш підходить для тих малюнків, де колір і атмосфера 

більш важливі, ніж дрібні деталі. 

Пастель досить проста в застосуванні. Для створення кольорових 

поверхонь достатньо накласти широкі штрихи і розтерти пальцями на 

папері. Можна також змішувати 2 і більше кольорів, накладаючи штрихи 

бічною поверхнею пастелі (різних відтінків) і розтираючи їх повністю або 

частково. При малюванні пастеллю зазвичай фон і загальні деталі наби-

рають шляхом змішування. А потім, поверх, тонкими лініями опрацьову-

ють деталі. Деталі й тонкі лінії також можна опрацьовувати пастельними 

олівцями (пастельні палички в оболонці з деревини). 

Розглянемо процес створення ілюстрації пастеллю. 

Для створення ілюстрації знадобляться пастельна крейда (масляна 

пастель), фактурний папір (акварельний або пастельний), інструменти 
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для розтушовування (ватні палички або ватні диски), вологі серветки, гум-

ка типу "клячка" для видалення зайвих колірних плям з аркуша паперу, 

при цьому не ушкоджуючи паперовий шар. Також знадобиться кольорове 

зображення (одне або декілька) для відтворення його в техніці пастелі 

(рис. 4.1). 

 

 
 

Рис. 4.1. Вихідні зображення для створення ілюстрації 

 

1. Перенесіть зображення на фактурний папір за допомогою світ-

лового столу і пастельної крейди. Почніть розфарбовувати ескіз базовим 

кольором, додаючи відблиски білою крейдою (рис. 4.2). 

 

 
 

Рис. 4.2. Початок роботи з ескізом 
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2. Розтушуйте зафарбовані поверхні, як подано на рис. 4.3. 

 

 
 

Рис. 4.3. Розтушована поверхня зображення 

 

3. Додайте додаткові відтінки, відблиски, щоб отримати об’єм, а по-

тім розтушуйте їх (рис. 4.4). 

 

 
 

Рис. 4.4. Опрацювання деталей зображення (1) 
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Додайте додаткові відблиски, щоб отримати об’єм, а потім розту-

шуйте їх, як показано на рис. 4.5. 

 

 
 

Рис. 4.5. Опрацювання деталей зображення (2) 

 

Додайте додаткові відтінки та розтушуйте їх, як показано на рис. 4.6. 

 

 
 

Рис. 4.6. Опрацювання деталей зображення (3) 
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Додайте додаткові відтінки та розтушуйте їх, як показано на рис. 4.7. 

 

 
 

Рис. 4.7. Опрацювання деталей зображення (4) 

 

Додайте додаткові відтінки та відблиски, та розтушуйте їх, як пока-

зано на рис. 4.8. 

 

 
 

Рис. 4.8. Опрацювання деталей зображення (5) 
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Додайте додаткові відтінки та розтушуйте їх, як показано на рис. 4.9. 

 

 
 

Рис. 4.9. Опрацювання деталей зображення (6) 

 

Додайте додаткові відблиски, та розтушуйте їх, як показано на рис. 4.10. 

 

 
 

Рис. 4.10. Опрацювання деталей зображення (7) 
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Готовий малюнок подано на рис. 4.11. 
 

 
 

Рис. 4.11. Готовий малюнок 
 

Завдання 

1. Виберіть вихідне зображення з папки, зазначеної викладачем,  

і за допомогою світлового столу і пастельної крейди зробіть ескіз на фак-

турному папері білого кольору. 

2. Розфарбуйте малюнок пастельними крейдами, орієнтуючись на 

кольорове зображення вихідного малюнка. 

3. Підготуйте кольоровий фактурний папір. Для цього можна скори-

статися акварельними фарбами та затонувати білий папір або придбати 

готовий. 

4. Виконайте роботу зі створення ілюстрації пастеллю на кольоро-

вому папері (можна взяти за основу інше зображення). 

5. Спробуйте закріпити одну з ілюстрацій лаком для волосся або 

спеціальним фіксатором. 

6. Проаналізуйте результати. Порівняйте ілюстрації на білому та ко-

льоровому папері. У якому випадку зображення виглядає ефектніше і чому? 

Як поводиться пастель на тонованому папері (якщо ви проводили тону-

вання)? Як виглядає ілюстрація до і після закріплення? 

7. У звіт необхідно помістити: 

а) вихідне зображення; 

б) готову ілюстрацію на білому папері; 
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в) готову ілюстрацію на кольоровому або тонованому папері; 

г) готову ілюстрацію закріплену; 

д) висновки (див. п. 6 завдання). 

 

 

Лабораторна робота № 5 

Тема "Техніка малювання гуашшю" 

 

Мета роботи – навчитися створювати ескізи методом змальову-

вання, а також розфарбовувати їх у техніці малювання гуашшю. 

Дана лабораторна робота сприяє напрацюванню наступних компе-

тентностей у відповідності до Національної рамки кваліфікації: 

Знання: 

інструменти та матеріали для створення ілюстрацій; 

особливості техніки створення ілюстрацій; 

допоміжні добавки для покращення властивостей фарби; 

властивості фарб, інструментів, паперу для технік малювання; 

особливості пензлів для малювання, їх види та властивості;  

особливості гумок для стирання, їх види та властивості; 

нестандартні техніки ілюстрування. 

Уміння: 

вибирати і застосовувати інструменти та матеріали для створення 

ілюстрацій; 

вибирати і застосовувати техніки створення ілюстрацій; 

використовувати властивості фарб, інструментів та паперу для тех-

нік малювання; 

вибирати і застосовувати нестандартні техніки створення ілюстрацій. 

Комунікації: 

аргументована взаємодія з авторами при виборі матеріалів для 

створення ілюстрацій; 

аргументована взаємодія з авторами при виборі технік для ство-

рення ілюстрацій; 

уточнити характеристики пристроїв і машин, на яких планується 

друкувати тираж. 

Автономність і відповідальність: 

пошук сучасніших інструментів в ілюструванні; 

вибір іншої техніки ілюстрування при незадовільному результаті. 
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Хід роботи 

 

У даній лабораторній роботі буде розглянуто приклад малювання 

весняної верби у техніці гуаш (рис. 5.1).  

 

 
 

Рис. 5.1. Готовий малюнок у техніці гуаш, mtdesign.ru 

 

Для того, щоб створити дану композицію, потрібно виконати наступ-

ні дії: 

1. Намалюйте фон (рис. 5.2). Для нього використовуйте синю, жов-

ту, червоно-коричневу і білу фарбу. Фон повинен бути блідим, тому на 

палітрі всі фарби треба змішувати з білою і плавно переходити від однієї 

до іншої. Для цієї роботи краще підійде широкий плоский пензель із ще-

тини. 
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Рис. 5.2. Фон 
 

2. На червоно-коричневій ділянці невеликими мазками намалюйте 

воду. Мазки треба накладати, не чекаючи, коли фарба висохне. На палітрі 

змішайте синю фарбу з білою, мазки робіть різними, додаючи то більше 

білої, то трохи чорної фарби (рис. 5.3). 

 

 
 

Рис. 5.3. Вода 

 

3. На далекому березі річки також мазками намалюйте ліс. Попере-

ду ліс малюйте мазками, змішуючи на палітрі чорну, білу, синю, жовту 

фарби (можна трохи темно-зеленої). Смуга лісу не повинна бути занадто 

яскравою, тому додайте обов’язково білу фарбу для зменшення насиче-

ності. Але й не робіть ліс дуже блідим, інакше верба на світлому фоні 

буде виглядати не так яскраво, як хотілося б.  
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4. Ззаду нанесіть ще мазки, тепер вже дуже блідо, майже як небо 

(рис. 5.4). 

 

 
 

Рис. 5.4. Ліс і небо 

 

5. Такими ж широкими мазками намалюємо ближній до вас берег 

(рис. 5.5). Так як яскравої і соковитої трави ще немає, візьміть для берега 

жовту, коричневу фарби, охру, трохи зеленої фарби. Тіні промальовуйте 

сіро-синім кольором. Можна промальовувати силуети кущів або дерев, 

тільки не дуже докладно, так як важливий, у першу чергу, передній план. 

 

 
 

Рис. 5.5. Близький берег 
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6. Стіл, на якому буде стояти ваза з вербою, буде дерев’яним,  

можна його поки промальовувати горизонтальними смужками широким 

пензлем. Необхідно трохи зробити темними нижні (ближні до вас) дошки 

(рис. 5.6). 

 

 
 

Рис. 5.6. Фон столу 

 

7. Обрис скляної вази можна намалювати олівцем або пензлем,  

як показано на рис. 5.7. 

 

 
 

Рис. 5.7. Обрис скляної вази 

 

8. Так як ваза скляна, стіл буде просвічуватися через неї. Тінь буде 

теж не суцільна – темною по краях, а в середині можна залишити неза-

фарбоване місце. 
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Рис. 5.8. Імітація скляної вази 

 

9. Сонце світить яскраво, тому додайте жовті мазки і білі відблиски. 

У тіні теж промальовуйте мазки жовтого і білого кольору. 

Намалюйте у вазі гілочки верби темно-коричневою фарбою, потім 

тонким пензлем у деяких місцях додайте чорного кольору (рис. 5.9). 

 

 
 

Рис. 5.9. Гілочки верби у вазі 
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10. Змішавши жовту і білу гуаші, намалюйте на гілочках бруньки 

верби. Кілька бруньок можна намалювати на столі (рис. 5.10). 

 

 

 

Рис. 5.10. Бруньки верби 

 

11. Серцевина у бруньок верби буде трохи темніша, тому невели-

ким пензлем промалюйте в середині світлих плям темні місця. Для цьо- 

го можна використовувати коричневу фарбу, змішавши її на палітрі з бі-

лою. 

Можна по краю бруньок намалювати найтоншим пензлем (№ 1) точ-

ки білою або жовтою фарбою. Тоді верба вийде більш пухнастою. Але це 

зовсім необов’язково. 

На столі під бруньками, що впали, необхідно промалювати тінь 

(рис. 5.11). 
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Рис. 5.11. Готовий малюнок 

 

Завдання 

1. Виконайте ескіз майбутнього малюнка методом замальовування 

зі зразка, виданого викладачем, на папері в клітинку або міліметровому 

папері. 

2. Перенесіть ескіз на ватман або картон за допомогою світлового 

столу. 

3. Використовуючи методичні рекомендації, розфарбуйте малюнок 

у техніці гуаш. 

Дана лабораторна робота не передбачає письмового звіту. Ескіз  

і готовий малюнок здаються в папці-портфоліо викладачеві разом з ре-

зультатами інших лабораторних робіт. 
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Змістовий модуль 2. Ілюстрування  

із використанням програмного забезпечення 

 

Лабораторна робота № 6 

Тема "Техніка створення ілюстрацій з пластиліну" 

 

Мета роботи – навчитися створювати площинні та об’ємні ілюст-

рації з допомогою кольорового та скульптурного пластиліну, а також пе-

ретворювати їх у цифрову форму. 

Дана лабораторна робота сприяє напрацюванню наступних компе-

тентностей у відповідності до Національної рамки кваліфікації: 

Знання: 

інструменти та матеріали для створення ілюстрацій; 

особливості техніки створення ілюстрацій; 

допоміжні добавки для покращення властивостей фарби; 

властивості фарб, інструментів, паперу для технік малювання; 

особливості пензлів для малювання, їх види та властивості;  

особливості гумок для стирання, їх види та властивості; 

нестандартні техніки ілюстрування. 

Уміння: 

вибирати і застосовувати інструменти та матеріали для створення 

ілюстрацій; 

вибирати і застосовувати техніки створення ілюстрацій; 

використовувати властивості фарб, інструментів та паперу для тех-

нік малювання; 

вибирати і застосовувати нестандартні техніки створення ілюстрацій. 

Комунікації: 

аргументована взаємодія з авторами при виборі матеріалів для 

створення ілюстрацій; 

аргументована взаємодія з авторами при виборі технік для ство-

рення ілюстрацій; 

уточнити характеристики пристроїв і машин, на яких планується 

друкувати тираж. 

Автономність і відповідальність: 

пошук сучасніших інструментів в ілюструванні; 

вибір іншої техніки ілюстрування при незадовільному результаті. 
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Хід роботи 

 

1. Створення пластилінових ілюстрацій на площині. 

Для основи ілюстрацій використовується щільний картон. Якщо 

фон покривається частково, потрібно використовувати картон з кольоро-

вим покриттям, на якому не будуть друкуватися плями від пластиліну. 

Для різання пластиліну і нанесення його на основу використовується 

стек – інструмент, у якого один кінець ніжеобразний, а інший гострий. 

Малювати ескізи ілюстрацій потрібно тільки олівцем. 

Залежно від об’ємності деталей ілюстрації можуть мати плоске або 

барельєфне зображення. У плоских ілюстрацій поверхня рівна, подібна 

олійному живопису. У барельєфному зображенні фігури злегка виступа-

ють над поверхнею. 

Нанесення пластиліну на основу слід починати з верхньої частини, 

щоб виключити торкання долоні з покритими ділянками. 

При створенні об’ємних зображень застосовуються два способи ліп-

лення: конструктивний (деталь складається з окремих частин) і пластич-

ний (форма витягується з пластичної маси). 

Деталі круглих і овальних форм формуються скачуванням пласти-

лінових кульок з подальшим розплющування при закріпленні на полотні 

ілюстрації. Для зображення тонких смуг виконуються валики, які розко-

чуються долонями на площині. 

Ефект пухнастості і пухкості елементів ілюстрації досягається тер-

тям або продавлюванням пластиліну через металеве ситечко. Таким 

способом зображуються хутро тварин, корали, рослинність і т. д. 

Пластилін змішується так само, як фарби. Так як білий колір є осно-

вою для багатьох відтінків (рожевого, блакитного, сірого і т. д.), його зна-

добиться більше, ніж пластиліну інших кольорів. Для отримання найкра-

щого результату при змішуванні кольорів потрібно брати невеликі шматочки 

пластиліну. Якісний пластилін відрізняється яскравістю, еластичністю, не 

прилипає до рук, не залишає плям на руках і робочої поверхні. 

Розглянемо процес створення ілюстрацій на прикладі композиції 

"Зимова ніч". 

Композиційною основою даної ілюстрації (рис. 6.1) є контраст тем-

ного неба з освітленим місяцем снігового покриву. 
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Рис. 6.1. Ілюстрація "Зимова ніч" 

 

Послідовність виконання роботи: 

1. На щільному картоні зробіть ескіз пейзажу. 

2. У верхній частині картини чорним пластиліном намалюйте небо. 

Матеріал розітріть пальцем або стеком. 

3. Область сніжного покриву зробіть зі злегка перемішаного білого  

і синього пластиліну. 

4. На тлі чорного неба вималюються гілки дерев і чагарників зі світ-

лого пластиліну. На стовбурах беріз темними крупинками зробіть горизон-

тальні смужки. 

5. У правій частині неба з білого пластиліну виліпити місяць. 

6. З валиків чорного пластиліну викладіть хатинку, колодязь, лавку. 

7. Лінії борозни на віддаленій дорозі покажіть темними прозорими 

смугами. 

8. Сніг на даху хатинки, колодязі, лавці, тонкі бурульки, засніжену 

огорожу виліпити з тонких валиків білого пластиліну. 

9. Сформуйте білим пластиліном дим з труби і розсип зірок на небі. 

10. Оформіть роботу у світлій рамці. 
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2. Створення об’ємних пластилінових ілюстрацій. 

Процес створення об’ємних пластилінових ілюстрацій передбачає 

використання тих же матеріалів, що і для плоских, за винятком того,  

що для основи фігури повинен використовуватися скульптурний пласти-

лін, а в якості криючого матеріалу – кольоровий. Також в процесі роботи 

можуть знадобитися дріт і зубочистки для створення каркасів фігур. 

Розглянемо процес створення об’ємної пластилінової ілюстрації на 

прикладі ліплення фігури собаки (рис. 6.2, конструктивний спосіб ліплення). 

1. Голова і вуха  

а) скатайте одну коричневу і одну білу кульку розміром з горошину 

(вуха), одну білу кульку побільше (голова), одну маленьку коричневу куль-

ку (плямочка) і одну найменшу чорну – ніс; 

б) коричневу і білу кульки розкатайте в два невеликих валика. З бі-

лої кульки розміром побільше розкачайте товстий валик (голова). Роз-

плющите маленький коричневий валик в коржик (плямочка), а з чорної 

кульки сформуйте маленький короткий валик (ніс) (рис. 6.2); 

в) розплющите коричневий і білий валики в довгасті коржики (вуха). 

Проробіть невелику ямку у верхній частині голови і прикріпіть на цьому 

місці коричневу плямку. До середини нижньої частини голови прикріпіть 

чорний носик; 

г) прикріпіть собаці вуха, як показано на рис. 6.5. 

 

 

 

Рис. 6.2. Процес ліплення собаки: голова та вуха 
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2. Брови й очі. 

а) скачайте дві дуже маленькі коричневі кульки, дві маленькі блакит-

ні кульки (очі) і дві маленькі чорні намистинки (зіниці); 

б) розкачайте коричневі кульки в маленькі валики (брови); 

г) до середини кожного ока приліпіть зіницю; 

д) прикріпіть до морди собаки спочатку брови, а потім очі (рис. 6.3). 

 

 
 

Рис. 6.3. Процес ліплення собаки: брови і очі 

 

3. Тулуб 

а) скатайте одну велику білу кульку і дві коричневі кульки – одну 

маленьку, другу трохи більше; 

б) білу кульку розкатайте в товстий валик і надайте йому форму 

яйця (тулуб). Розплющіть коричневі кульки в невеликі коржі (цятки), як 

подано на рис. 6.4; 

в) прикріпіть цятки до тулуба собаки. У верхню частину тулуба за-

строміть половинку зубочистки; 

г) насадіть деталь голови собаки на зубочистку і прикріпіть її до ту-

луба. 

 

 
 

Рис. 6.4. Процес ліплення собаки: тулуб 
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4. Лапки 

а) скачайте одну коричневу кульку і три білі кульки розміром з вели-

ку горошину; 

б) отримані кульки розкачайте у валики. Один кінець кожного отри-

маного валика повинен бути товще, ніж інший (лапки); 

в) щоб лапки собаки придбали правильну форму, потовщені кінці 

валиків потрібно трохи розплющити. Акуратно підніміть розплющені кінці 

задніх лапок (див. рис. 6.6); 

г) прикріпіть білий і коричневий валики (передні лапи) вгорі з боків 

тулуба. Два валика, які залишилися (задні лапи) до тулуба внизу і надай-

те їм таку форму, як показано на рис. 6.6. 

5. Хвіст і подушечки на лапах 

а) скачайте одну коричневу кульку розміром з горошину і вісім 

дуже маленьких рожевих кульок (подушечки на лапах), як подано на  

рис. 6.5; 

б) коричневу кульку розкачайте в конусоподібний валик і надайте 

йому форму хвоста; 

в) приліпіть хвіст до задньої частини тулуба. До кожної ступні на 

задніх лапах собаки прикріпіть по чотири рожеві подушечки. 

 

 

 

Рис. 6.5. Процес ліплення хвоста і подушечки на лапах 
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Рис. 6.6. Процес ліплення собаки 

 

Отриману фігуру можна використовувати в ілюстрації (рис. 6.7). 
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Рис. 6.7. Ілюстрація з використанням фігурки собаки 

 

Завдання 

1. Виберіть літературно-художній твір, який будете ілюструвати  

в пластиліновій техніці. Створіть ескіз однієї ілюстрації до цього твору 

(ескіз відскануйте). 

2. Розфарбуйте чернетку ескізу такими фарбами, щоб визначитися 

з колірною гамою майбутньої ілюстрації (розмальовану чернетку відска-

нувати). 

3. Виберіть тип пластилінової ілюстрації – на площині або об’ємну, 

а також спосіб створення – конструктивний або пластичний. 
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4. Керуючись методичними рекомендаціями, створіть ілюстрацію до 

вибраного твору. Ілюстрація повинна відповідати всім правилам компо-

зиції та дизайну. 

5. Сфотографуйте 5 проміжних етапів створення ілюстрації. 

6. Сфотографуйте готову ілюстрацію. 

7. В якості звіту до даної лабораторної роботи потрібно здати папку 

в електронному вигляді, яка повинна містити скановані зображення:  

а) ескізу; б) розфарбованого ескізу, а також фотографії проміжних про-

цесів створення ілюстрації і готового результату. Також необхідно здати 

кольоровий роздрукований варіант готової пластилінової ілюстрації із 

зазначенням назви літературно-художнього твору, вашого прізвища, іні-

ціалів та номера групи. 

 

 

Лабораторна робота № 7 

Тема "Техніка створення коміксу: створення персонажів" 

 

Мета роботи – навчитися створювати динамічних і емоційних пер-

сонажів для коміксу, використовуючи основні правила побудови персо-

нажа. 

Дана лабораторна робота сприяє напрацюванню наступних компе-

тентностей у відповідності до Національної рамки кваліфікації: 

Знання: 

поняття коміксу. Особливості створення персонажів для друкованих 

та електронних видань (статичних та анімованих). Техніки створення ко-

міксу. Фан-арт у коміксах;  

концепт-арт як складова процесу створення коміксу. 

Уміння: 

створювати персонажів для друкованих видань;  

створювати персонажів для електронних видань; 

створювати статичних та анімованих персонажів; 

створення коміксів; 

створення коміксів за різними техніками; 

створення концепт-арт коміксу; 

Комунікації: 

творча взаємодія з дизайнером щодо концепт-арт коміксу; 
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здатність переконувати авторів у необхідності застосування ство-

рених персонажів у коміксах; 

творча взаємодія з дизайнером в області техніки створення колажу. 

Автономність і відповідальність: 

обґрунтування і ухвалення рішення про використання в коміксах 

персонажів; 

творчий підхід до розробки персонажів коміксу. 

 

Хід роботи 

 

Дана лабораторна робота складається з трьох частин (створення 

персонажів, створення ескізу коміксу, обрисовка коміксу засобами ство-

рення та обробки цифрової графіки) і виконується парами. Методичні ре-

комендації містять довідковий матеріал для виконання першої частини 

лабораторної роботи. 

Комікс (від англ. комічний – смішний) – розповіді в картинках. Комікс 

поєднує риси таких видів мистецтва, як література та образотворче мис-

тецтво. 

Лабораторна робота передбачає реалізацію однієї смуги коміксу 

формату А4 з попереднім створенням концепції, сценарію і персонажів. 

Розглянемо процес створення персонажа для коміксу на прикладі 

малювання персонажа Арнольда (рис. 7.1) з мультфільму "Гей, Ар-

нольд!". 

 

 
 

Рис. 7.1. Персонаж Арнольд 
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Весь процес складається з наступних етапів: 

1. Намалюйте базові лінії для визначення пози персонажа (рис. 7.2). 

Не забувайте, що голова Арнольда має форму м’яча для американського 

футболу, що потрібно врахувати при створенні базових ліній. 

 

 
 

Рис. 7.2. Створення базових ліній, що визначають позу персонажа 

 

2. Грубими лініями прималюйте голову і риси обличчя, а також нама-

люйте два трикутника, що позначають комір сорочки Арнольда (рис. 7.3). 

 

 
 

Рис. 7.3. Ескіз голови персонажа 

 

3. Намалюйте персонажу волосся. Воно має гострі кути і розташо-

вані по обидва боки від головного убору. Враховуйте те, що волосся пе-

рсонажа хоч і "стирчить" у різні сторони, але, тим не менше, його кінчики 
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спадають вниз, таким чином надаючи зачісці природний вигляд. Потім 

промалюйте верхню частину тулуба (рис. 7.4). 

 

 
 

Рис. 7.4. Створення волосся і тулуба персонажа 

 

4. Закінчіть базовий начерк персонажа опрацюванням нижньої час-

тини тулуба (ніг і сорочки, що виглядає з-під светра), а також деталізаці-

єю кистей рук. 

 

 
 

Рис. 7.5. Фінальний вигляд базового начерку 

 

5. Витріть всі базові лінії (або перемалюйте малюнок на чистовик  

за допомогою світлового столу) і додайте деталей персонажу (рис. 7.6). 
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Рис. 7.6. Готовий ескіз персонажа 

 

Ще один приклад створення людиноподібних персонажів (семи 

гномів з мультфільму "Білосніжка і сім гномів") подано на рис. 7.7а та 

рис. 7.7б. 

 

1. 

 

2. 

 
 

3. 

 

4. 

 
 

Рис. 7.7а. Процес створення семи гномів 
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5. 

 
 

Рис. 7.7б. Процес створення семи гномів 

 

Персонажі коміксу не завжди мають вигляд, подібний людському. 

Досить часто це можуть бути тварини або вигадані істоти. 

Приклад створення персонажа-тварини Тімона з мультфільму "Ті-

мон і Пумба" подано на рис. 7.8а та рис. 7.8б.  
 

1. 

 
3. 

 

2. 

 
4. 

 
 

Рис. 7.8а. Процес створення персонажа Тімона 
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5. 

 

6. 

 
 

Рис. 7.8б. Процес створення персонажа Тімона 

 

Приклад створення персонажа – риби Флаундера з мультфільму 

"Русалонька" подано на рис. 7.9а та рис. 7.9б. 

 

1. 

 

2. 

 

3. 

 

4. 
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Рис. 7.9а. Процес створення персонажа Флаундера 

5. 

 

6. 

 

 

Рис. 7.9б. Процес створення персонажа Флаундера 

 

При створенні персонажа для коміксу не забувайте, що: 

1. Персонаж не повинен бути постійно під одним кутом зору (рис. 7.10). 

 

 

 

Рис. 7.10. Голови персонажів під різним кутом зору 

 

2. Всі пози і жести повинні відображати загальний настрій персона-

жа. Приклад виконання різних жестів подано на рис. 7.11. 
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Рис. 7.11. Жести 

 

Для того, щоб більш точно передати позу (рис. 7.12) персонажа, 

можна використовувати манекен, дзеркало або фотографії аналогічних 

поз. 
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Рис. 7.12. Пози 
 

Завдання 

1. Об’єднайтеся в команди по дві особи в кожній. Продумайте ідею 

майбутнього коміксу, визначте загальну концепцію створення персонажів, 

придумайте персонажам імена. Кожен учасник команди повинен створити 

свого персонажа, який внаслідок буде грати ключову роль у коміксі. 

2. Виходячи зі сценарію коміксу, намалюйте п’ять поз свого персо-

нажа і окремо п’ять емоцій (тільки голова). Емоції необхідно підписати. 

Перенесіть результати на чистовик будь-якого формату за допомогою 

світлового столу. 

3. Результати виконання лабораторної роботи повинні бути оформ-

лені у вигляді презентації після закінчення виконання третьої частини 
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даної лабораторної роботи (зміст і вимоги до презентації будуть видані  

в завданні до третьої частини лабораторної роботи). Всі ескізи (чернетки 

та чистовик) потрібно здати викладачеві в кінці модуля в папці-порт-

фоліо. 

 

Лабораторна робота № 8 

Тема "Техніка створення коміксу: складання смуг коміксу" 

 

Мета роботи – навчитися створювати ескіз смуги коміксу шляхом 

компонування раніше створених зображень у фрейми з опрацюванням 

задніх планів і додаванням діалогів. 

Дана лабораторна робота сприяє напрацюванню наступних компе-

тентностей у відповідності до Національної рамки кваліфікації: 

Знання: 

поняття коміксу. Особливості створення персонажів для друкованих 

та електронних видань (статичних та анімованих). Техніки створення ко-

міксу. Фан-арт у коміксах;  

концепт-арт як складова процесу створення коміксу. 

Уміння: 

створювати персонажів для друкованих видань;  

створювати персонажів для електронних видань; 

створювати статичних та анімованих персонажів; 

створення коміксів; 

створення коміксів за різними техніками; 

створення концепт-арт коміксу; 

Комунікації: 

творча взаємодія з дизайнером щодо концепт-арт коміксу; 

здатність переконувати авторів у необхідності застосування ство-

рених персонажів у коміксах; 

творча взаємодія з дизайнером в області техніки створення колажу. 

Автономність і відповідальність: 

обґрунтування і ухвалення рішення про використання в коміксах 

персонажів; 

творчий підхід до розробки персонажів коміксу. 
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Хід роботи 

 

Дана лабораторна робота складається з трьох частин (створення 

персонажів, створення ескізу коміксу, обрисовка коміксу засобами ство-

рення та обробки цифрової графіки) і виконується парами. Методичні ре-

комендації містять довідковий матеріал для виконання другої частини 

лабораторної роботи. 

На погляд В. Сахнова, існують такі правила створення "ідеального" 

коміксу: 

1. Комікс повинен починатися і закінчуватися окремої смугою (НЕ роз-

воротом).  

2. Перша смуга коміксу повинна містити великий кадр із загальним 

планом, насиченим деталями, що подають до розгляду, який показує чи-

тачеві, де і коли відбувається дія. 

3. Остання смуга коміксу повинна містити великий кадр із загаль-

ним планом, насиченим деталями, що подають до розгляду. 

4. Композиція коміксу завжди будується розворотами (крім першої 

та останньої смуги). 

5. Дія на розвороті становить собою закінчений епізод, як абзац  

у літературному тексті. Кадр – пропозиція (закінчена думка), розворот – 

абзац.  

6. Дія на розвороті розгортається з верхнього лівого кута в нижній 

правий кут. Відповідно, сцени (включають від одного до декількох кадрів) 

на кожному розвороті за важливістю розподіляються так: а) верхній лівий 

кут; б) верхній правий кут; в) нижній правий кут; г) нижній лівий кут. 

Всі основні дії, що здійснюються головними персонажами, всі основ-

ні слова, які вони говорять, розташовуються на цій осі. У нижньому лівому 

кутку розташовуються допоміжні сцени, розшифровка місця і часу дії  

за допомогою деталей обстановки і реплік додаткових персонажів. 

7. Кожен розворот закінчується кадром, що спонукає читача пере-

горнути сторінку, щоб дізнатися, що відбудеться далі. Тобто в останньо-

му кадрі кожного розвороту міститься незакінчена дія, результат якої чи-

тач бачить тільки на наступній сторінці. Це запитання без відповіді, яку 

читач отримує, тільки перегорнувши сторінку. Такий кадр називається 

"гачок". 

8. Дія в кожному кадрі розвивається так само, як і на всьому розво-

роті – у цілому напрямку "зліва направо". Рух у кадрі "справа наліво" 
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означає зупинку розвитку історії, перешкоду, яку має подолати герой, і т. п. 

Кожен рух у кадрі "справа наліво" – виняток, причини якого автор пови-

нен чітко собі формулювати. 

9. Персонаж, розташований біля краю кадру, ближнього до краю 

смуги, повинен бути розгорнутий у бік центру смуги. Виняток: якщо тільки 

дія навмисне не виводиться за край кадру – персонаж "йде". Враховуючи 

п. 6 та 7, головний герой завжди повинен знаходитися зліва по кадру. 

10. У коміксі діє те ж правило чергування крупності, що і в кіно.  

У ряді послідовних кадрів крупності повинні чергуватися. Плани бувають: 

деталь / макроплан (у кадрі вміщаються об’єкти розміром з невелику час-

тину людського тіла: пальці, губи, очі; крупний план (у кадрі уміщується 

голова людини або трохи більше – по груди), середній план (від грудного 

плану до колінного), загальний план (людина в ріст і загальне), найбільш 

загальний план ("люди-мурахи"). Найпоширеніший виняток з цього пра-

вила – "вісімка" – прийом показу діалогу, коли по черзі показуються  

однаковою крупністю обидва персонажі, що говорять, зняті під певним 

кутом. Кілька кадрів підряд, що містять персонажі, зображені в одній кру-

пності, надлишок "балакучих голів" і т. п. стомлюють читача. 

11. Оскільки дія на розвороті розвивається з верхнього лівого кута 

в нижній правий, горизонтальні кадри викликають відчуття уповільнення 

дії, а вертикальні – викликають відчуття прискорення дії. Тому у верти-

кальних кадрах краще розташовувати сцени з прискореною дією, а в го-

ризонтальних – з продовженою дією і панорамами. 

12. Також вертикальні кадри використовуються для передачі від-

чуття висоти і падіння, а горизонтальні – відчуття протяжного простору. 

13. Час в коміксі передається за допомогою простору аркуша папе-

ру, на якому він надрукований. Отже, дія, вміщена в кадр більшого роз-

міру, займає більше часу, ніж дія, вміщена в маленький кадр. У найбіль-

ших кадрах може відбуватися одночасно кілька дій, розтягнутих у часі.  

У самих маленьких кадрах показується частина однієї короткої дії. 

14. Кількість "поверхів" на смузі в збалансованій історії має дорів-

нювати трьом, максимум чотирьом. Проте їх числом можна варіювати 

залежно від потреб сюжету. Збільшення кількості поверхів збільшує кіль-

кість кадрів, що призводить до ущільнення дії. Також максимізацію кіль-

кості кадрів можна використовувати для підкреслення скупченості, обме-

женості простору. Тому під ключові сцени слід виділяти на смузі більше 
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місця, обмежуючи кількість поверхів і, відповідно, кадрів – збільшуючи ро-

змір кожного з них. 

15. Комікс – візуальне мистецтво, тому на нього поширюються ті ж 

закони, що і на живопис, графіку і т. п. Тут мається на увазі те, що смуга / 

розворот коміксу так само, як картина, повинен мати композиційний 

центр. Кожна смуга повинна містити мінімум один кадр із загальним пла-

ном, який показує читачеві, де і коли відбувається дія. Він не обов’язково 

повинен бути настільки ж великим, як загальні плани на першій і останній 

смугах коміксу, але бажано робити його побільше. Таким чином, розво-

рот повинен містити як мінімум два кадри із загальними планами. Роз-

ташовуючи їх один ближче до початку, а інший ближче до кінця розворо-

ту, буде показано читачеві, яка дія, зображена на розвороті, вплинула на 

навколишній простір. 

16. Кадри на розвороті повинні бути різного розміру. Кілька кадрів 

однакового розміру поспіль стомлюють читача і заважають сприйняттю: 

виникає монотонність, що заплутує погляд, читачеві стає важче зрозумі-

ти, що слідує за чим. 

17. Також допомагає сприйняттю рознесення по горизонталі прога-

лин. Наскрізний вертикальний пробіл змушує погляд ковзати вниз по 

смузі, не затримуючись на зображенні. Наскрізний горизонтальний про-

біл, навпаки, сприяє правильному сприйняттю коміксу. 

18. Кадр без рамок (кордонів, стінок) передає "позачасовість".  

Таким чином передається "замороженість" або символічність дії, в остан-

ньому випадку зображувана дія стає символом чогось більшого, ілюст-

рацією якоїсь абстрактної ідеї. 

19. У великих кадрах задній план повинен бути деталізований,  

тобто на ньому має бути зображено все те, що в реальному житті там 

було б видно. У маленьких кадрах, де передається швидка дія, фон не 

потрібен взагалі, він лише заважає сприйняттю. Також фон не потрібен  

у кадрах з "головами, що говорять", де головним є пряма мова і її джере-

ло – говорить голова. 

20. Для передачі глибини кадру у випадках, коли це необхідно, фон 

відділяється від переднього плану декількома основними способами, які 

можна поєднувати: а) об’єкти на передньому плані мають зовнішній  

абрис більш товстими лініями, ніж об’єкти на задньому плані; б) об’єкти 

на передньому плані передаються з більшим ступенем деталізації, ніж 

об’єкти на задньому плані; в) на об’єкти переднього плану наносяться 
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більш щільні і різкі тіні, ніж на об’єкти заднього плану; г) об’єкти перед-

нього плану передаються з нормальною деталізацією, об’єкти заднього пла-

ну передаються масою суцільних тіней (наприклад, герої на передньому 

плані повернуті до нас обличчям і не бачать, як хтось підкрадається  

до них ззаду); д) об’єкти заднього плану передаються з нормальною де-

талізацією, об’єкти переднього плану передаються масою суцільної тіні 

(ефект "підглядання з кущів"). 

21. Одним з основних переваг коміксу перед іншими видами мисте-

цтва є його здатність зображати дію одночасно з різних точок зору. У не-

відривному зв’язку з цією здатністю існує специфічна проблема компози-

ції коміксу, а саме: коректне зчленування між собою вертикальних і гори-

зонтальних кадрів. Навіть майстрам коміксу часом доводиться ставити 

пояснюючі стрілочки, щоб читач не заплутався в чергуванні кадрів.  

22. Дрібниці з композиції кадру: 

а) порожній простір перед рухомим об’єктом / персонажем; 

б) обрізання голови на середніх / великих планах; 

в) "саджання на горизонт"; 

г) "вісімка". 

23. Важливе місце в коміксі займає текст. Некоректне використання 

текстових балонів і шрифтів зіпсувало не один комікс, у інших аспектах 

виконаних майстерно. 

24. Композиція кожного кадру коміксу, який повинен містити текст, 

повинна заздалегідь плануватися під нього. Зразкова пропорція: на кадрі 

з текстом під балон відводиться половина простору. Наприклад, якщо  

в кадрі дається тільки коротка репліка, під неї виділяється місце, розмір-

не місцем для інших персонажів. Тобто балон = персонаж. 

25. Шрифт повинен бути рукописний, так як ваша рука рисувальни-

ка неминуче видасть щось гармонійне до вашого малюнку. Але якщо не-

має – користуйтеся спеціальними коміксових шрифтами. 

26. У коміксі текст набирається ЗАВЖДИ у верхньому регістрі. 

27. Розміром шрифту (кеглем) можна і потрібно варіювати для того, 

щоб передавати різні смислові відтінки мови, а також умови її виголо-

шення. Так, гучний крик передається кеглем, крупніше того, що викорис-

товується для стандартної мови, плюс шрифт робиться напівжирним. 

Можливо навіть використання іншого шрифту, типу для звукових ефек-

тів, оскільки відчайдушний крик – це вже майже звуковий ефект. Навпа-
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ки, слова, сказані пошепки або "в сторону" другорядними персонажами 

на задньому плані, можна передавати зменшеним кеглем. 

28. У текстовому балоні між самим текстом і кордонами балона повин-

ні залишатися поля. Будьте люб’язні заздалегідь так планувати насичення 

смуги текстом, щоб не доводилося поміщати в один балон забагато слів. 

29. Самі балони для стандартного тексту можуть бути будь-якої 

форми. Тут я не великий фахівець, який не заглиблювався поки, але в 

цілому треба намагатися, щоб балони відповідали стилю малюнка і сти-

лю історії. Покладайтеся на почуття внутрішньої гармонії. Балони можуть 

бути круглі, овальні, прямокутні, прямокутні із закругленими краями і т. п. 

У прямокутні балони вміщається максимальна кількість тексту. 

30. Комікс народжується у взаємодії картинок і тексту. Авторський 

текст бажано зводити до мінімуму. При достатку авторського тексту ко-

мікс перетворюється на ілюстрацію з поясненнями. Найкраще місце для 

авторського тексту в коміксі – його початок і кінець. 

 

У класичному вигляді процес створення коміксу складається з таких 

етапів: 

1. На звичайному аркуші формату А4 малюється чорновий скетч 

без детального промальовування об’єктів, але з розміткою фреймів і ви-

значенням розташування балонів (рис. 8.1). 

 

 
 

Рис. 8.1. Чернетка скетчу коміксу 
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2. На чистому аркуші формату А3 робиться розмітка фреймів. 

3. Фрейми заповнюються відповідними зображеннями з якомога  

точнішою деталізацією (малюнок виконується простим олівцем). 

4. Лайнером обводяться всі написи, фломастером – контури фрей-

мів, а чорнилом – контури балонів та зображень у фреймах (рис. 8.2). 

 

 
 

Рис. 8.2. Обробка надписів  

 

Обробку контурів фреймів подано на рис. 8.3. 

 

 
 

Рис. 8.3. Обробка контурів фреймів 
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Обробку контурів вмісту фреймів подано на рис. 8.4. 

 

 
 

Рис. 8.4. Обробка контурів вмісту фреймів 

 

Результат створення контурів коміксу подано на рис. 8.5. 

 

 
 

Рис. 8.5. Результат створення контурів коміксу 
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5. Після того, як чорнила висохнуть, комікс сканується по частинах  

і потім "зшивається" за допомогою програмного продукту Adobe Photo-

shop (рис. 8.6). 
 

 
 

Рис. 8.6. Комікс, готовий для фарбування в Adobe Photoshop 

 

Завдання (виконується парами) 

1. Ознайомтесь з правилами створення коміксу, описаними в пер-

шій частині методичних рекомендацій. Дотримуючись цих правил, скла-

діть чорновий скетч коміксу на аркуші паперу А4 (див. рис. 8.1). 

2. Створіть ескіз коміксу в олівці, промальовуючи якомога доклад-

ніше всі деталі і діалоги, на аркуші паперу формату А3. Команда з одного 

або двох чоловік малює одну смугу (сторінку) коміксу, команда з трьох 

чоловік – дві. 

3. Якщо необхідно, обробіть контури зображень коміксу лайнером, 

фломастером або тушшю (див. рис. 8.3, рис. 8.4 та рис. 8.5). Якщо кон-

тури надалі будуть вимальовуватися в Adobe Photoshop, контури на па-

пері не потрібні. 

4. Відскануйте зображення по частинах з роздільною здатністю 300 dpi 

і зшийте його за допомогою Adobe Photoshop. 
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Лабораторна робота № 9 

Тема "Техніка створення коміксу: 

цифрова обробка коміксу" 

 
Мета роботи – навчитися розфарбовувати комікс за допомогою 

програми створення та обробки цифрової графіки Adobe Photoshop. 

Дана лабораторна робота сприяє напрацюванню наступних компе-

тентностей у відповідності до Національної рамки кваліфікації: 

Знання: 

поняття комікс. Особливості створення персонажів для друкованих 

та електронних видань (статичних та анімованих). Техніки створення ко-

міксу. Фан-арт у коміксах; 

концепт-арт як складова процесу створення коміксу. 

Уміння: 

створення персонажів для друкованих видань;  

створення персонажів для електронних видань; 

створення статичних та анімованих персонажів; 

створення коміксів; 

створення коміксів за різними техніками; 

створення концепт-арт коміксу. 

Комунікації: 

здатність переконувати авторів у необхідності застосування ство-

рених персонажів у коміксах; 

творча взаємодія з дизайнером щодо концепт-арт коміксу; 

творча взаємодія з дизайнером в області техніки створення колажу. 

Автономність і відповідальність: 

обґрунтування і ухвалення рішення про використання в коміксах 

персонажів; 

творчий підхід до розробки персонажів коміксу. 

 
Хід роботи 

 
Методичні рекомендації складаються з двох частин: 1. Закінчення 

роботи з прикладом, описаним у частині 2 лабораторної роботи; 2. Урок  

з малювання інструментом "Перо" в Adobe Photoshop. 
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Частина 1 

Для того, щоб розфарбувати ескіз, створення якого було описано  

в методичних рекомендаціях до другої частини даної лабораторної робо-

ти, необхідно виконати такі дії: 

1. Потрібно перевести зображення в чорно-білий вигляд і зробити 

чорні лінії більш контрастними, виконавши команду Image > Adjustments 

> Поріг. Далі потрібно перевести зображення в колірну модель CMYK 

(якщо комікс призначено до друку офсетним способом), виконавши ко-

манду Image > Mode > CMYK.  

Створіть два нових шари (один для балонів і написів, інший – для 

фону фреймів), перемістіть шар з відсканованим зображенням угору, за-

лийте шар з фоном фреймів (він повинен бути нижнім) кольором зелено-

блакитного відтінку і для шару з відсканованим зображенням задайте 

режим накладення шарів Multiply (рис. 9.1). Очистіть ластиком на шарі  

з фоном фреймів ділянки, що не відносяться до фреймів, а також за-

фарбуйте білим кольором балони з написами на відповідному шарі. 

 

 
 

Рис. 9.1. Режим накладення шарів Multiply 

 

Результат виконання накладання шарів подано на рис. 9.2. 
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Рис. 9.2. Результат виконання накладання шарів 

 

2. Залийте шар з балонами і шар із фоном фреймів (рис. 9.3). 

 

 
 

Рис. 9.3. Об’єднання шару балонів із шаром фону 
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3. За допомогою інструмента "Чарівна паличка" (Magic Wand) виді-

ляйте окремі ділянки зображення і заливайте їх відповідними кольорами 

на шарі з фоном (рис. 9.4). 

 

 
 

Рис. 9.4. Процес розфарбовування коміксу 

 

Процес розфарбовування коміксу подано на рис. 9.5. 

 

 
 

Рис. 9.5. Процес розфарбовування коміксу  
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4. Додайте в комікс додаткові деталі (хмари, листя) за допомогою 

пензлів або швидких масок та інструменту заливки. Результат подано  

на рис. 9.6. 

 

 

 

Рис. 9.6. Деталізація зображення 

 

Готовий комікс зображений на рис. 9.7. 
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Рис. 9.7. Готовий комікс 

 

Частина 2 

Часті випадки, коли немає можливості використовувати графічний 

планшет для створення ілюстрацій. Одним із способів рішення даної 

проблеми є використання інструменту Pen Tool в Adobe Photoshop. 

Розглянемо основні властивості даного інструменту на прикладах. 

Приклад. Основи використання Pen Tool 

Створіть нове полотно, розміром 5х9 см. Виберіть Pen Tool з пара-

метром лінія, а не форма. 
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Натисніть у будь-якому місці полотна; там де натиснули, повинна 

з’явилася точка (рис. 9.8). 

 

 
 

Рис. 9.8. Точка на полотні 

 

Тепер натисніть на іншій ділянці полотна (з’явилася нова точка). 

Тепер клікніть на середині лінії (рис. 9.9). 

 

  
 

Рис. 9.9. Лінія, намальована інструментом Pen Tool 

 

Утримуючи Ctrl, натисніть на середній точці. Тепер рухайте лінію, 

згинаючи її, як подано на рис. 9.10. При натиснутій клавіші Ctrl лінія буде 

вигинатися симетрично, при натиснутій клавіші Alt – тільки з одного боку. 

Також при натиснутій клавіші Ctrl можна переміщати опорні точки лінії. 

 

 
 

Рис. 9.10. Вигин лінії 

 

Натисніть на праву кнопку миші і виберіть "обвести шлях" (Strock 

Path). З’явиться лінія шляху (рис. 9.11) (колір і розмір обведення шляху 

залежить від пензля, який в даний момент є пензлем за замовчуванням). 
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Рис. 9.11. Лінія шляху 

 

Змінити характер лінії. Натисніть праву кнопку миші і виберіть "об-

вести шлях" (Strock Path). Натисніть на прямокутник, який імітує натиск 

(Pressure). Натисніть "Ok" правою кнопкою – видалити шлях (рис. 9.12). 

 

 
 

Рис. 9.12. Лінія, яка імітує натиск 

 

Далі необхідно застосувати отримані навички на практиці. Для цього: 

1. Відкрийте скетч (рис. 9.13);  

 

 
 

Рис. 9.13. Скетч майбутньої ілюстрації 

 

2. Зменшить прозорість скетчу на 50 %, результат подано на рис. 9.14.  
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Рис. 9.14. Результат зменшить прозорість скетчу на 50 % 

 

3. Створіть новий шар над скетчем, назвіть його "line". Збільште 

масштаб зображення на 200 – 500 %. Виберіть Pen Tool і нанесіть лінії, 

використовуючи техніку, подану вище (рис. 9.15). Коли ви обведете одну 

ділянку, натисніть Ctrl і натисніть у будь-якому місці на полотні, а тоді поч-

неться наступна лінія.  

Малюйте обличчя на одному шарі, волосся – на іншому. 
 

 
 

Рис. 9.15. Процес малювання ліній 
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Готове обведене зображення показано на рис. 9.16. 
 

 
 

Рис. 9.16. Обведений скетч 

 

Коли ви закінчите обводити малюнок, має бути 4 шари: обличчя, 

волосся, тіло і квіти (рис. 9.17).  
 

 
 

Рис. 17. Шари ілюстрації 
 

Тепер необхідно розфарбувати ілюстрацію. 
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4. Помістіть шари зі скетчем наверх і оберіть "Multiply" в налашту-

ваннях шарів. 

5. Створіть новий шар над шаром обличчя, встановіть йому прозорість 

50 %, режим накладення "Color" і намалюйте на ньому очі (рис. 9.18). 
 

 
 

Рис. 9.18. Розфарбовані очі 
  

6. Намалюйте шкіру. Для цього створіть новий шар, але помістіть 

його під шар зі скетчем. Виберіть режим накладення "Multiply" для цього 

шару. Колір шкіри буде мати приблизно такі параметри: # FFE4B8,  

# FFDCAD, # FCC283, # EDA14F. 

Використовуйте м’який пензель з прозорістю 60 %. 

Почніть з самого блідого кольору # FFE4B8. Після цього малюйте 

темним кольором із прозорістю 50 % (рис. 9.19).  
 

 
 

Рис. 9.19. Розфарбовування шкіри 
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7. Необхідно намалювати блузку. Виберіть всю блузку на зобра-

женні (зробіть маску за допомогою того ж інструменту Pen Tool: обведіть 

потрібну область і при натисканні правої кнопки миші оберіть "Make 

Selection", потім виберіть заливку (Fill) – зразок (Pattern) і виберіть зра-

зок, який подобається, як показано на рис. 9.20. 
 

 
 

Рис. 9.20. Розфарбована блузка 

 

8. Намалюйте волосся. Все ще використовуючи м’який пензель, 

виберіть колір # FFC835, жовтий або будь-який інший. Замалюйте всю 

поверхню волосся, як подано рис. 9.21.  

 

 
 

Рис. 9.21. Базовий тон волосся 
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Виберіть м’який пензель, прозорість 30 %, колір – білий. Намалюй-

те відблиски на волоссі (рис. 9.22).  

 

 
 

Рис. 9.22. Відблиски на волоссі 

 

9. Намалюйте квітку: виберіть рожевий колір і замальовуйте м’яким 

пензлем (режим накладення Normal і прозорість 100 %). Після цього ви-

беріть режим накладання для пензля Overlay і намалюйте відблиски на 

квітці з прозорістю 50 %, як подано на рис. 9.23. 

 

 
 

Рис. 9.23. Ілюстрація з готовою квіткою 
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Можна намалювати крапочки на квітці, змінивши розмір пензля  

за допомогою діалогового вікна "Настроювання нового пензля".  

Готова квітка з нанесеними крапками меншими розмірами подана 

на рис. 9.24. 

 

 
 

Рис. 9.24. Деталізація квітки за допомогою пензля 

 

10. Також можна використовувати Pen Tool, щоб намалювати від-

блиски на очах дівчини. Відблиски потрібно залити білим кольором.  

Виберіть жорсткий пензель і намалюйте маленькі відблиски блакитного  

і білого кольору, як подано на рис. 9.25. 

 

 
 

Рис. 9.25. Відблиски на очах 

 

Кінцевий результат поданий на рис. 9.26.  
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Рис. 9.26. Кінцевий результат створення ілюстрації 

 

Завдання (виконується парами) 

1. Ознайомтеся з методичними рекомендаціями до даної лабора-

торної роботи і оберіть спосіб відтворення і розфарбовування коміксу. 

2. Розподіліть обов’язки з обробки коміксу між членами команди 

(можливо, кожен буде розфарбовувати свій фрейм, можливо, хтось буде 

робити базову заливку, а хтось – деталізацію). 

3. Залиште готовий комікс в форматі jpeg і роздрукуйте його на ко-

льоровому принтері (формат повинен бути A4). 

4. Підготуйте презентацію, яка повинна містити: 

назву коміксу (обґрунтувати, чому саме така); 

опис концепції створення коміксу (легенда, дійові особи, опис світу, 

у якому відбуваються події); 

сценарій частини історії (або всієї історії повністю), яка підлягала 

цифровий обробці; 

опис персонажів (характер, скетчі, варіанти міміки і поз); 

чорнові скетчі смуги коміксу з позначеними балонами; 

чистові скетчі коміксу; 

комікс після сканування; 

комікс після розфарбовування; 
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висновки і враження після створення коміксу; 

інформацію про команду. 

 

 

Лабораторна робота № 10 

Тема "Відцифровування та ретушування ілюстрацій" 

 

Мета роботи – навчитися відцифровувати ілюстрації, навчитися ба-

зовим прийомам та техніці ретуші, яка допоможе покращити ілюстрації. 

Дана лабораторна робота сприяє напрацюванню наступних компе-

тентностей у відповідності до Національної рамки кваліфікації: 

Знання: 

техніки створення ілюстрацій у растрових редакторах;  

техніки створення ілюстрацій у векторних редакторах; 

техніки малювання у растрових та векторних редакторах;  

використання фільтрів та плагінів для створення візуальних ефектів; 

поєднання растрової та векторної техніки при створенні цифрової 

ілюстрації. 

Уміння: 

створювати ілюстрації у растрових редакторах; 

створювати ілюстрації у векторних редакторах; 

використовувати фільтри та плагіни для створення візуальних ефек-

тів; 

поєднувати растрову та векторну техніки при створенні цифрової 

ілюстрації. 

Комунікації: 

обговорити з дизайнером можливість використання фільтрів та 

плагінів для посилення виразності ілюстрацій; 

спільно з автором обговорювати необхідність поєднання растрової 

та векторної технік у створенні ілюстрацій. 

Автономність і відповідальність: 

прийняття рішення про досягнення цілей при використані фільтрів 

та плагінів для створення візуальних ефектів; 

пошук нових підходів до створення векторних або растрових ілюст-

рацій; 

теоретична і практична підготовка фахівців з використання растро-

вої та векторної графіки. 
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Хід роботи 

 

Ретуш фотокарток відноситься до удосконалення рис обличчя,  

таких як очі, губи і шкіра, при цьому не викликаючи почуття неприроднос-

ті. Для цього використовуються інструменти "Освітлення / Затемнення" 

(Dodge / Burn), щоб змінити освітлення на волоссі, щоб додати йому більше 

обсягу, а також на очах і губах, щоб вони виглядали більш привабливо. 

Колірна корекція буде проводитися за допомогою коригувальних 

шарів, таких як "Колірний Баланс" (Color Balance) для додаткової корек-

ції, а також, щоб не втратити якість ілюстрації під час робочого процесу. 

Використаємо інструмент "Штамп" (Clone Stamp) для дублювання дета-

лей, а також застосуємо фільтр "Ефекти Висвітлення" (Lighting Effects) 

для заключного поліпшення всього освітлення. 

1. Ретуш шкіри 

Перше завдання для поліпшення портрета – це виправлення будь-

яких дефектів на шкірі. Для цього використайте інструмент "Точковий 

пензель відновлення" (Spot Healing Brush Tool) для видалення світлових 

відблисків, дрібних яскравих пікселів навколо очей і в області чола,  

а також інструмент "Мікс Кисть" (Mixer Brush) для пом’якшення шкіри,  

як подано на рис. 10.1. Даний інструмент працює краще, ніж будь-який 

фільтр розмиття, при цьому він зберігає текстуру шкіри. 

 

 
 

Рис. 10.1. Використання інструменту  

"Точковий пензель відновлення" 

 

2. Перша колірна корекція 

Давайте змінимо настрій зображення за допомогою коригувальних 

шарів. Для цього використайте "Карту Градієнта" (Gradient Map) для того, 
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щоб перерозподілити колірні відтінки на тінях і освітленні. Використаємо 

градієнт за замовчуванням від фіолетового до помаранчевого, необхідно 

змінити помаранчевий відтінок на # ecaf68. Змініть режим накладення 

для коригуючого шару на "М’яке світло" (М’яке світло), зменшіть непро-

зорість шару до 30 %, як подано на рис. 10.2. 

 

 
 

Рис. 10.2. Колірна корекція 

 

3. Корекція контрасту 

Проведіть корекцію контрасту зображення за допомогою "Рівнів" 

(Levels) або "Кривих" (Curves). Освітлення на даному зображенні трохи 

розмите, тому необхідно підсилити освітлення, використавши значення 

235 коригуючого шару "Рівні" (Levels). Також необхідно трохи освітлити 

"Середні тони" (Midtones), змістивши значення до 1,05. Зображення ста-

ло виглядати яскравіше (рис. 10.3). 

 

 
 

Рис. 10.3. Корекція контрасту



4. Узорні пензлі (пензлі для нанесення орнаменту) 

Використаємо круглий жорсткий пензель для того, щоб намалювати 

кілька точок під очима. Щоразу поступово зменшуйте розмір пензля при 

нанесенні окремої точки. Потім продублюйте шар для правого ока, за-

стосуйте шар-маску при необхідності. Використовуйте режим накладення 

"М’яке світло" (Soft light), задайте непрозорість шару 100 %, як подано на 

рис. 10.4. 
 

 
 

Рис. 10.4. Використання "Узорного пензля" 

 

5. Нанесення косметики 

Для створення тіней для повік (рис. 10.5) використовуйте великий 

м’який пензель. Колір, який використовується для цього, – не найголов-

ніше, головне – спробуйте застосувати інтенсивність різних відтінків, по-

ки не підберете відповідний відтінок. На окремому шарі виконайте те ж 

саме, тільки з нижньою повікою, при цьому використовуючи інший колір-

ний відтінок. Режим накладення, який використовується – "Перекриття" 

(Overlay). 
 

 
 

Рис. 10.5. Нанесення косметики 
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6. Покращуємо якість нанесеної косметики 

Як тільки ви грубо нанесли косметику, до обох шарів з косметикою 

додайте шар-маски для корекції та покращення нанесеної косметики. 

Для отримання натурального ефекту макіяжу використовуйте великий 

м’який пензель на шар-масках, зменшивши непрозорість пензля до при-

близно 25 % (рис. 10.6). Використовуйте коригувальний шар "Тон / Наси-

ченість" (Hue / Saturation) для вибору кольору косметики. Використовуйте 

різні коригувальні шари для верхньої повіки, інший – для нижньої повіки. 

Шар-маски використовуйте для пом’якшення або корекції макіяжу. 

 

 
 

Рис. 10.6. Коригуємо нанесення косметики 

 

7. Затемнення і освітлення 

Створіть новий шар і далі за допомогою команди "Редагування / 

Заливка" (Edit/Fill) заливаємо 50 % сірим кольором (50 % сірого). Змініть 

режим накладення для цього шару на "Перекриття" (Overlay), і на цьому 

ж шарі застосуйте інструменти "Освітлення / Затемнення" (Dodge / Burn), 

значення "Експозиції" (Exposure) 3 – 5 %, як подано на рис. 10.7. Ство-

ріть світлові відблиски за допомогою інструменту "Освітлювач" і тіні за 

допомогою інструменту "Затемнення", використовуючи м’який пензель 

середнього розміру. 

Інструменти Освітлення / Затемнення" (Dodge / Burn) добре підхо-

дять для поліпшення якості зображення. Використовуючи дуже низьке 

значення "Експозиції" (Exposure) 3 – 6 %, можна змінити структуру тіла 

шляхом створення світлових бликів і тіней. Наприклад, можна добитися 

того, щоб очі стали виразнішими шляхом інтенсивного освітлення століт-

тя і райдужної оболонки ока за допомогою невеликого м’якого пензля  
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зі значенням експозиції 20 – 30 % залежно від зображення. Дана техніка 

може також застосовуватися в області корекції губ і волосся. 

 

 
 

Рис. 10.7. Використання інструментів затемнення і освітлення 

 

5. Підсилюємо виразність очей і покращуємо волосся 

Збільшуємо значення "Експозиції" (Exposure) до приблизно 25 %  

і зменшуємо розмір пензля. Перебуваючи на тому ж самому шарі, який 

залили 50 % сірим, застосуємо інструмент "Освітлювач" до повік очей, 

щоб повіки стали світлішими, а також до волосся. Продублюйте даний 

шар для посилення ефекту, як подано на рис. 10.8. 

 

 
 

Рис. 10.8. Підсилення виразності очей і покращення волосся 
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9. Колірний Баланс 

Мета корекції "Колірного Балансу" (Color Balance) – це колірна ко-

рекція всього зображення. Зробимо зображення більш "холодним", зок-

рема це стосується параметрів середніх тонів і тіней шляхом додавання 

більшої кількості відтінків блакитного і синього кольору, як подано на  

рис. 10.9. Кількість доданого кольору з кожного каналу залежить від ва-

ших уподобань. 

 

 
 

Рис. 10.9. Використання "Колірного Балансу" (Color Balance) 
 

10. Колір губ 

Міняємо колір губ за допомогою коригувального шару "Тон / Наси-

ченість" (Hue / Saturation) на рис. 10.10. Створіть коригувальний шар, за-

лийте шар-маску коригувального шару чорним кольором, потім за допо-

могою білого пензля пофарбуйте область губ, щоб ефект проявився 

тільки на губах. Використовуйте три параметри коригувального шару для 

корекції інтенсивності і яскравості кольору. 
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Рис. 10.10. Результат завдання кольору вустам 

 

11. Додайте деталей, використовуючи дорогоцінні камені 

За допомогою зображення дорогоцінного каміння, яке знаходиться 

в папці до матеріалів лабораторної роботи, зробіть зображення дівчини 

більш цікавим. Змініть масштаб зображення дорогоцінних каменів у від-

повідності з зображенням, а потім продублюйте стільки разів, скільки не-

обхідно. Можна змінити колір каменів за допомогою коригувального шару 

"Кольоровий тон / Насиченість" (Hue / Saturation). Застосуйте невелике 

значення опції стилів шару "Тіні" (Drop Shadow) для створення більшого 

реалізму, як подано на рис. 10.11. 

 

 

 

Рис. 10.11. Результат додавання деталей до зображення 
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12. Створення дублікату Троянди 

За допомогою інструменту "Штамп" (Clone Tool) створіть дублікат 

троянди на волоссі дівчини. Уникайте створення точної копії троянди 

шляхом зміни налаштувань параметра "Джерело клонів" (Clone Source 

Properties), який можна активувати через "Вікно / Клонування джерела" 

(Window Clone Source). Просто утримуючи клавішу Alt, натисніть на ори-

гінальне зображення троянди, далі на новому шарі намалюйте дублікат 

троянди. Результат створення троянди подано на рис. 10.12. 

 

 
 

Рис. 10.12. Результат створення троянди 

 

13. Заключний Світловий Ефект 

Створіть новий шар поверх усіх шарів, а потім, перебуваючи на но-

вому шарі, натисніть клавіші Shift + Ctrl + Alt + E, щоб об’єднати всі шари 

на новому шарі. До цього шару застосуйте фільтр "Ефекти Висвітлення" 

(Lighting Effects filter), далі – "Фільтр / Рендеринг / Ефекти Висвітлення" 

(Filter / Render / Lighting Effects). Метою даного заключного ефекту є за-

темнення кутів зображення, щоб привернути увагу спостерігача до об-

личчя дівчини.  
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Рис. 10.13. Результат виконання ефекту висвітлення 

 

Завдання  

1. Ознайомтеся з методичними рекомендаціями до даної лабора-

торної роботи. 

2. Відретушуйте ілюстрацію використовуючи методичні рекоменда-

ції до даної лабораторної роботи. 

3. Створіть звіт за результатами виконання лабораторної роботи. 
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Лабораторна робота № 11 

Тема "Колажування" 

 

Мета роботи – освоїти техніку Matte Painting для створення фото-

колажів як способу ілюстрування літературно-художніх творів; освоїти 

компетенції щодо створення ілюстрацій, а саме по роботі зі світлотінню, 

роботі з повітряною перспективою і глибиною різкості, вписуванню об’єк-

тів в оточення, імітації руху в кадрі, кольорокорекції в Adobe Photoshop. 

Дана лабораторна робота сприяє напрацюванню наступних компе-

тентностей у відповідності до Національної рамки кваліфікації: 

Знання: 

техніки створення ілюстрацій у растрових редакторах;  

техніки створення ілюстрацій у векторних редакторах; 

техніки малювання у растрових та векторних редакторах;  

використання фільтрів та плагінів для створення візуальних ефектів; 

поєднання растрової та векторної техніки при створенні цифрової 

ілюстрації. 

Уміння: 

створювати ілюстрації у растрових редакторах; 

створювати ілюстрації у векторних редакторах; 

використовувати фільтри та плагіни для створення візуальних ефектів; 

поєднувати растрову та векторну техніки при створенні цифрової 

ілюстрації. 

Комунікації: 

обговорити з дизайнером можливість використання фільтрів та пла-

гінів для посилення виразності ілюстрацій; 

спільно з автором обговорити необхідність поєднання растрової та 

векторної технік у створенні ілюстрацій. 

Автономність і відповідальність: 

прийняття рішень про досягнення цілей при використані фільтрів та 

плагінів для створення візуальних ефектів; 

пошук нових підходів до створення векторних або растрових ілюст-

рацій; 

теоретична і практична підготовка фахівців з використання раcтро-

вої та векторної графіки. 
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Хід роботи 

 

Matte Painting – це техніка створення зображень на основі колажу  

з вихідних (референсних) матеріалів. Для виготовлення "Мейта" можуть 

бути використані фотографії, традиційне і комп’ютерне малювання, три-

вимірна графіка тощо, так само як будь-які їх довільні комбінації. У ре-

зультаті художник створює повноцінне зображення із заданою темою, 

стилем, з потрібним настроєм або іншим завданням, яке було визначено 

на початку. Дана методика має найширше застосування в сучасній індуст-

рії виробництва комп’ютерних ігор, кіно, ілюструванні. 

Згідно з правилами даної техніки, у сценах Matte Painting не повин-

но бути потенційно рухомих об’єктів (адже вони накладаються вже у ві-

део). Але художники часто вписують їх, щоб продемонструвати всю масш-

табність кадру. У методичних рекомендаціях до даної лабораторної ро-

боти буде подано поетапний процес створення фотоколажу в техніці 

Matte Painting з використанням у композиції рухливих об’єктів. Для ство-

рення колажу (результат можна побачити на рис. 11.1) необхідно вико-

нати наступну послідовність дій: 

 

 

 

Рис. 11.1. Результат створення колажу, автор Inspiks 

 

1. Відкрийте зображення, на якому будуть розвиватися дії в ілюст-

рації. У даному випадку це Великий Каньйон (файл Grand_Canyon.jpg), 

рис. 11.2. 

 



89 

 
 

Рис. 11.2. Великий Каньйон 

 

2. Далі необхідно додати небу ще більше "драматизму". Відкрийте 

вихідне зображення "Захід на озері Повів" (файл lake.jpg). "Обріжте" його 

по горизонталі, рис. 11.3. 

 

 
 

Рис. 11.3. Процес редагування зображення "Захід на озері Повів" 

 

3. Розгорніть картинку з озером по горизонталі. Зайдіть в "Зображен-

ня – Обертати Зображення – Відобразити по горизонталі" (Image > Image 

Rotation > Flip Canvas Horizontally). Зробити це треба для того, щоб знайти 
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точне співвідношення між зображенням і джерелом світла. У даному випа-

дку світло повинне падати з неба на певну ділянку озера (рис. 11.4).  

 

 

 

Рис. 11.4. Відбите зображення "Захід на озері Повів" 

 

4. Активуйте інструмент "Клонування" (Сone Tool) і видаліть темні 

гори (рис. 11.5).  

 

 

 

Рис. 11.5. Відредаговане зображення з хмарами 

 

5. Скопіюйте та вставте зображення з озером в основний документ 

з каньйоном (назвіть цей шар "Захід"). Тепер трохи змініть масштаб зо-

браження із заходом сонця. Орієнтуйтеся на лінію горизонту. Щоб ре-

зультат вийшов задовільним, зайдіть в "Редагувати – Трансформувати – 

Масштабувати" (Edit > Transform > Scale). Утримуйте клавішу Shift при 

масштабуванні, тоді зображення не виглядатиме "рваним" (рис. 11.6). 
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Рис. 11.6. Комбіноване зображення з хмарами і Великий Каньйон 

 

6. Зробіть маску шару. Це необхідно, щоб добре влити шар "Захід 

сонця" у фоновий шар. Не забувайте, що результат роботи завжди пови-

нен виглядати природньо (рис. 11.7).  

 

 
 

Рис. 11.7. Покращене суміщення зображень 
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7. Виділіть шар "Захід" і зайдіть у "Шар – Маска шару – Показати 

всі" (Layer > Layer Mask > Reveal All). Візьміть пензель середнього розмі-

ру, встановіть кольор переднього плану "чорний" і промалюйте область 

під горами. Для створення реалістичного зображення не забувайте міня-

ти розмір пензлів (рис. 11.8). 

 

 
 

Рис. 11.8. Результат редагування маски шару 

 

8. Для того, щоб "оживити" задній план, потрібно додати зображен-

ня винищувача. Відкрийте зображення fighter.jpg і видаліть з нього бла-

китний фон, залишивши тільки сам винищувач (рис. 11.9) за допомогою 

інструменту "Чарівна паличка" (Magic Wand tool).  

 

 
 

Рис. 11.9. Винищувач, "витягнутий" з фону 
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9. Скопіюйте та вставте винищувач в основний документ. Розгор-

ніть його по горизонталі (Flip Horizontally) і змініть розмір. Краще всього 

розмістити винищувач у лівій частині композиції (рис. 11.10). 

 

 
 

Рис. 11.10. Розміщення винищувача в основної композиції 

 

10. Також варто зменшити прозорість винищувача до 35 %, розгорну-

ти його приблизно на 20 градусів і зменшити. Тепер дублюйте шар таким 

чином, щоб вийшло чотири винищувачі, як показано на рис. 11.11.  

 

 
 

Рис. 11.11. Винищувачі на задньому фоні 
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11. Повторіть усі дії, зазначені в п. 8, тільки з зображенням винищу-

вача F-15 (файл f15.jpg). Результат повинен вийти таким, як показано на 

рис. 11.12.  

 

 
 

Рис. 11.12. Витяг винищувача F-15 з фону 

 

12. Помістіть винищувач з правого боку композиції (прозорість шару – 

48 %), продублюйте два рази і розташуйте копії, як показано на рис. 11.13. 

 

 
 

Рис. 11.13. Композиція з винищувачами 

 

13. Для передачі простору необхідно додати ще один винищувач 

(файл tornado.jpg). Вийміть його з фону за допомогою "Чарівної палички" 

(Magic Wand Tool). Зайдіть у "Зображення – Корекція – Тон / Насиче-

ність" (Image – Adjustments – Hue / Saturation). Встановіть параметри: на-

сиченість (-72), колірний тон (+148), як показано на рис. 11.14.  
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Рис. 11.14. Тонова корекція зображення з літаком "Торнадо" 

 

14. Скопіюйте та вставте зображення літака "Торнадо" в документ, 

трохи масштабуйте (він повинен бути більше, ніж два інших літака), змен-

шіть прозорість до 70 – 80 %. Продублюйте отриманий шар два рази 

(рис. 11.15). 

 

 
 

Рис. 11.15. Розміщення літаків "Торнадо" в композиції 

 

15. Помістіть на передній план композиції зображення з файлу 

front.jpg, попередньо видаливши фон, як це виконувалося з іншими зо-

браженнями літаків (рис. 11.16). 
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Рис. 11.16. Зображення літака з файлу front.jpg з віддаленим фоном 

 

Результат подано на рис. 11.17. 

 

 
 

Рис. 11.17. Зображення винищувача, вставлене в композицію 

 

16. Скорегуйте освітленість літака на передньому плані, зайшовши 

в "Зображення – Корекція – Рівні" (Image > Adjustments > Levels), як по-

казано на рис. 11.18.  
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Рис. 11.18. Корекція освітленості зображення 

 

17. Зменшіть винищувач до 45 %, використовуючи "Зображення – 

Корекція – Масштабування" (Image > Adjustment > Scale), як подано на 

рис. 11.19.  

 

 

 

Рис. 11.19. Композиція із зменшеним винищувачем 

 

18. Дублюйте шар з винищувачем і застосуйте "Фільтр – Розмиття – 

Розмиття в русі" (Filter – Blur – Motion Blur) (рис. 11.20).  
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Рис. 11.20. Застосування фільтра розмиття до винищувача 

 

19. Трохи перемістіть вправо розмитий шар, встановіть йому про-

зорість 30 % і за допомогою інструменту "Ластик" (Еraser) середнього роз-

міру або "Ласо" (Lasso) видаліть розмитість на фронтальній частині літа-

ка (рис. 11.21).  

 

 
 

Рис. 11.21. Літак з віддаленим розмиттям у фронтальній частині 

 

20. Згрупуйте шар з винищувачем і його розмитий дублікат, зробіть 

ще два дубліката цих груп (рис. 11.22). Коли робите дублікати, створіть 

ефект того, що винищувач на передньому плані частково "перекриває" 

маленькі винищувачі на задньому плані, так додасте відчуття того, що 
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між літаками дійсно велика відстань, зображення буде виглядати ще 

більш реалістично. 

 

 
 

Рис. 11.22. Винищувачі на передньому плані 

 

21. Відкрийте файл big.jpg, і за допомогою "Чарівної палички" (Magic 

Wand Tool) і "Полігональному Ласо" (Polygon Lasso Tool) видаліть усі зайві 

елементи (рис. 11.23). 

 

 
 

Рис. 11.23. Результат видалення елементів за допомогою 

"Чарівної палички" 
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Результат виконання подано на рис. 11.24. 

 

 
 

Рис. 11.24. Результат видалення елементів за допомогою Лассо 

 

22. Вставте отримане зображення в основну композицію, трохи 

зменшивши його (рис. 11.25).  

 

 
 

Рис. 11.25. Композиція з доданим зображенням великого літака



23. Далі необхідно використовувати декілька ефектів освітлення, 

щоб зробити зображення ефектніше. Для цього необхідно скористатися 

корекційними шарами (Adjustment Layers). Додайте корекційний шар "Рівні" 

(Levels Adjustment Layer). Для цього клікніть на іконку, схожу на місяць, у ниж-

ній частині палітри шарів, і виберете з підміною корекційні шари "Рівні" 

(Levels). Можете використовувати такі настройки: 28, 1.16, 229 (рис. 11.26).  
 

 

Рис. 11.26. Використання корекційного шару в композиції 
 

24. Додайте до шару корекційний шар "Криві" (Curves Adjustment Layer). 

У підсумку передній план у вас повинен вийти темніше, ніж задній (рис. 11.27).  

 

Рис. 11.27. Затемнення переднього плану 
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25. Додайте шар, який доповнить колір заходу, Cyan +29, Magenta +13, 

Yellow +15 за допомогою корекційного шару "Колірний Баланс" (Color 

Balance Adjustment Layer) (рис. 11.28).  

 

 
 

Рис. 11.28. Корекція колірного балансу композиції (1) 
 

Також додайте ще один корекційний шар "Колірний Баланс" (Color 

Balance Adjustment Layer), який допоможе зміщувати колірну гаму всіх 

шарів. Встановіть такі настройки: Блакитний (Cyan) +48, Пурпурний (Ma-

genta) +37, Жовтий (Yellow) +62 (рис. 11.29).  
 

 
 

Рис. 11.29. Корекція колірного балансу композиції (2) 
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26. Додайте корекційний шар "Градієнт" (Gradient Adjustment Layer) 

з такою палітрою: колір 1 – # 066caa, колір 2 – # 008fc7, колір 3 – 

# c1dbe8 (рис. 11.30).  

 

 
 

Рис. 11.30. Створення корекційного шару "Градієнт" 
 

27. Змініть режим накладання шару на "М’яке світло" (Soft Light), 

поставте прозорість 82 %, результат показаний на рис. 11.31. 

 

 
 

Рис. 11.31. Результат застосування режиму накладення "М’яке світло" 

 

28. Проаналізувавши колірний баланс зображення, можна побачити, 

що воно містить занадто багато синіх відтінків. Для того щоб це випра-

вити, додайте маску шару до корекційного шару "Градієнт". Встановіть 
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кольором переднього плану чорний, потім клацніть на масці і промалюй-

те частини на передньому плані зображення (рис. 11.32). 

 

 
 

Рис. 11.32. Корекція колірного балансу зображення  

за допомогою маски 
 

29. Зменшіть прозорість шару "Градієнт" до тих пір, поки синій колір 

не залишиться тільки на задньому плані. Після цього ретельно видаліть 

синій відтінок з нижньої частини великого літака, щоб створити ефект  

відображення на його поверхні променів призахідного сонця (беріть то 

білий, то чорний пензель, щоб отримати хороший ефект, що треба – ви-

даляйте, що треба – відновлюйте) (рис. 11.33).  

 

 
 

Рис. 11.33. Результат доопрацювання зображення  

за допомогою шару "Градієнт" 
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30. Відкрийте зображення sun.jpg і перенесіть його в основний до-

кумент (рис. 11.34)  
 

 
 

Рис. 11.34. Композиція із зображенням з файлу sun.jpg 

 

31. Поставте зображення сонця під корекційними шарами. Змініть 

розмір і використовуйте спосіб накладення шару "Посвітління" (Screen) 

(рис. 11.35).  
 

 
 

Рис. 11.35. Результат накладення шарів 

 

32. Візьміть інструмент "Ластик" (Eraser) середнього розміру і вида-

літь зовнішні контури вогню, так зображення "увіллється" в загальний 

фон і не буде виділятися (рис. 11.36). 
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Рис. 11.36. Результат адаптації зображення з сонцем  

у загальній композиції 

 

33. За допомогою інструменту "Кадрування" (Сrop tool) обріжте зо-

браження так, щоб воно виглядало, як на рис. 11.37. Композиція готова.  

 

 
 

Рис. 11.37. Готова композиція 

 

Завдання 

1. Виконайте методичні рекомендації до даної лабораторної роботи 

і збережіть результат у форматі jpg. 

2. Створіть власний колаж у техніці Matte Painting за допомогою 

Adobe Photoshop, використовуючи зображення з Набору 1 або Набору 2, 

виданих викладачем. У композиції можна використовувати не менше  

шести будь-яких зображень з набору. Також можна доповнювати компо-
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зицію власними зображеннями. У процесі створення колажу обов’язково 

потрібно використовувати коригуючі шари. Результат роботи збережіть  

у форматі jpg. 

3. В якості результату виконання даної лабораторної роботи потрібно 

здати викладачеві 4 файли: вихідний (файл у форматі psd) з результа-

том виконання методичних рекомендацій, кінцевий результат виконання 

методичних рекомендацій (файл у форматі jpg), вихідний власного кола-

жу (файл у форматі psd), кінцевий результат створення власного колажу 

(файл у форматі jpg).  

 

 

Лабораторна робота № 12 

Тема "Створення цифрових ілюстрацій у векторних 

та растрових графічних редакторах" 

 

Мета роботи – навчитися створювати власні пензля і візуальні 

ефекти в Adobe Photoshop, а також використовувати їх при оформленні 

ілюстрацій. 

Дана лабораторна робота сприяє напрацюванню наступних компе-

тентностей у відповідності до Національної рамки кваліфікації: 

Знання: 

техніки перетворення намальованих та пластилінових ілюстрацій  

у цифрову форми;  

особливості використання апаратних засобів для оцифрування ілюст-

рацій;  

особливості ретушування оцифрованих ілюстрацій;  

особливості використання інструментів та фільтрів для обробки 

цифрових ілюстрацій. 

Уміння: 

перетворювати намальовані та пластилінові ілюстрації у цифрову 

форму; 

створювати, редагувати і застосовувати векторні об’єкти для отри-

мання фігур; 

створювати піктограми для електронних навчальних видань; 

ретушувати оцифровані ілюстрації;  

використовувати інструменти та фільтри для обробки цифрових 

ілюстрацій. 
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Комунікації: 

рекомендації авторам щодо ретушування відцифрованих ілюстрацій;  

спільно з автором обговорювати необхідність ретушування оциф-

рованих ілюстрацій;  

обговорити з дизайнером можливість використання апаратних за-

собів для оцифрування ілюстрацій. 

Автономність і відповідальність: 

приймати рішення про досягнення цілей при ретушуванні відциф-

рованих ілюстрацій; 

пошук нових підходів до ретушування відцифрованих ілюстрацій. 
 

Хід роботи 
 

1. Створення пензлів 

Дуже часто при оформленні ілюстрації необхідно використовувати 

унікальні пензлі, що відповідають стилю оформлення роботи. 

У Adobe Photoshop можна створювати нові пензлі, редагувати вже 

наявні і видаляти пензлі, які більше не потрібні. Можна створити тимча-

сові пензлі, які потрібні саме зараз. Потрібні для створення пензлі знахо-

дяться в меню (рис. 12.1): 1 – Edit / Редагування; 2 – Brush / Пензель; 3 – 

Pop-up Palette / Меню, що випадає. 
 

 
 

Рис. 12.1. Меню, необхідні для роботи з пензлями 
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Можна намалювати заготовку для пензля самостійно, а можна вико-

ристовувати будь-який вподобаний малюнок чи фото. Малюнок повинен 

бути поданий у відтінках сірого (grayscale) і на білому фоні (рис. 12.2), для 

того щоб ясніше уявляти, як виглядатиме пензель. Але можна викорис-

товувати і кольоровий малюнок. Розмір пензля може бути до 1024х1024 

пікселів. 
 

 
 

Рис. 12.2. Перетворення зображення у відтінки сірого 

 

Для створення пензля з існуючого малюнка необхідно його виділи-

ти, скопіювати в буфер обміну і потім за допомогою меню Edit > Define 

Brush Preset створити новий пензель (рис. 12.3).  
 

 
 

Рис. 12.3. Створення пензля 
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Назвіть пензель і натисніть Ok (рис. 12.4).  
 

 
 

Рис. 12.4. Визначення назви пензля 
 

Далі потрібно зберегти його в наборі пензлів за допомогою меню, 

що випадає (Brush > Save Brushes) (рис. 12.5). 

 

 
 

Рис. 12.5. Збереження пензля 

 

Пензель готовий (рис. 12.6), тепер його можна використовувати при 

створенні ілюстрацій. 

 

 

Рис. 12.6. Приклад використання пензля 
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2. Створення візуальних ефектів 

1. Створення вогняного кільця (рис. 12.7). 

 

 
 

Рис. 12.7. Результат створення візуального ефекту вогняного кільця 

 

При виконанні даного ефекту будуть використані пензлі, які знахо-

дяться в архіві Revnart_Smoke_by_revn89.zip у папці з матеріалами до 

лабораторної роботи. 

Крок 1. Створіть новий документ будь-якого розміру з чорним фо-

ном. Створіть новий шар і виберіть інструмент Elliptical Marquee Tool 

(Овальне виділення) з такими параметрами, як подано на рис. 12.8. 

 

 
 

Рис. 12.8. Параметри інструменту Elliptical Marquee Tool 

 

Затисніть клавішу SHIFT і намалюйте коло, як показано на рис. 12.9. 
 

 
 

Рис. 12.9. Результат створення кола з розміром розтушовування 4 px 
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Натисніть правою кнопкою миші на виділенні і виберіть Stroke (Об-

ведення) (рис. 12.10). 

 

 
 

Рис. 12.10. Створення обведення окружності 

 

Обведіть виділення з такими параметрами: (білий колір, ширина 2 px). 

Зменшить Opacity (Непрозорість) шару приблизно до 40 %, вийде 

ефект, як показано на рис. 12.11. 

 

 
 

Рис. 12.11. Кільце з напівпрозорим контуром 
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Крок 2. Скористайтеся пензлями з архіву, щоб додати текстурності 

колу. Створіть новий шар і виберіть один з пензлів набору, потім намалюй-

те дим, як показано на рис. 12.12 (перед роботою зменшіть розмір пензля). 

 

 
 

Рис. 12.12. Створення ефекту диму за допомогою пензля 

 

Використовуйте Edit >Transform > Warp (Редагування – Трансформа-

ція – Деформація), щоб трансформувати дим по контуру кола (рис. 12.13). 

 

 
 

Рис. 12.13. Трансформація диму по контуру кола 
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М’яким ластиком акуратно видаліть кінець лінії диму, щоб він плав-

но переходив у коло (рис. 12.14). 

 

 

 

Рис. 12.14. Видалення кінця ліній диму 

 

Продублюйте (CTRL + J) шар з димом кілька разів і розташуйте  

кожну копію навколо кола (рис. 12.15). 

Порада: Використовуйте Free Transform (Вільна трансформація) 

(CTRL + T), щоб повернути кожен шар і скоригувати його форму. 

 

 

 

Рис. 12.15. Ефект диму навколо кола 
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Об’єднайте всі шари з лінією диму (CTRL + E) і продублюйте (CTRL + 

+ J); вийшов шар у кілька разів. Потім за допомогою Free Transform  

(Вільна трансформація) (CTRL + T) трансформуйте дубльований шар, 

щоб додати більше ефекту (рис. 12.16). 
 

 
 

Рис. 12.16. Збільшення ефекту диму 

 

Створіть новий шар і намалюйте дим всередині кола, потім змен-

шіть Opacity (Непрозорість) шару приблизно до 20 % (рис. 12.17). 

 

 
 

Рис. 12.17. Дим всередині кола 

 

Додайте коригувальний шар Levels (Рівні) над усіма попередніми 

шарами (рис. 12.18). 



 
 

Рис. 12.18. Коригувальний шар Levels (Рівні) 

 

Відредагуйте маску шару, що коректує Levels (Рівні), як показано на 

рис. 12.19. 

 

 
 

Рис. 12.19. Редагування маски коригувального шару Levels (Рівні) 

 

На рис. 12.20 видно, що при додаванні коригувального шару збіль-

шились глибина і контраст диму). 
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Рис. 12.20. Збільшення глибини і контрасту диму 

 

Крок 3. Тепер необхідно додати простий світловий ефект на колі. 

Створіть новий шар над усіма попередніми і м’яким білим пензлем зро-

біть один клік, як показано на рис. 12.21. 

 

 
 

Рис. 12.21. Клік м’яким білим пензлем 

 

Деформуйте цей шар за допомогою Warp (Деформація) за формою 

кола (рис. 12.22). 
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Рис. 12.22. Деформація шару з відблиском 

 

Продублюйте (CTRL + J) цей шар кілька разів, щоб підсилити ефект 

(рис. 12.23). 

 

 

 

Рис. 12.23. Посилення ефекту світіння 

 

Повторіть цей процес на протилежній стороні кола (рис. 12.24). 
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Рис. 12.24. Результат створення світіння на протилежному боці кола 

 

Крок 4. Тепер необхідно додати ефект хмар навколо кола. Для цьо-

го створіть новий шар і намалюйте виділення за допомогою Elliptical 

Marquee Tool (Овальне виділення); розтушовка 40 px, усередині виділен-

ня згенеруйте хмари за допомогою фільтра Filter > Render > Clouds 

(Фільтр – Рендеринг – Хмари), як показано на рис. 12.25. 

 

 
 

Рис. 12.25. Додавання хмар 

 

Натисніть CTRL + L і застосуйте параметри для шару з хмарами,  

як показано на рис. 12.26. 
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Рис. 12.26. Редагування шару з хмарами 

 

Потім використовуйте Warp (Деформація), щоб трансформувати 

хмари, як показано на рис. 12.27 (це створить невеликий ефект руху 

сфери). 

 

 

 

Рис. 12.27. Деформація шару з хмарами 

 

Готовий результат подано на рис. 12.28. 
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Рис. 12.28. Результат редагування шару з хмарами 

 

Крок 5. Додайте ще ефекту диму вгорі і внизу сфери, як подано на 

рис. 12.29. 

 

 

 

Рис. 12.29. Додавання ефекту диму 
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Щоб додати золотий відтінок, створіть коригувальний шар Color 

Balance (Колірний баланс), відтінок (Shadows) над усіма попередніми 

шарами (рис. 12.30). 

 

 
 

Рис. 12.30. Налаштування коригуючого шару, Shadows 

 

Налаштування коригуючого шару Color Balance (Колірний баланс) / 

(Midtones) подано на рис. 12.31. 

 

 
 

Рис. 12.31. Налаштування коригуючого шару, Midtones 



123 

Налаштування коригуючого шару Color Balance (Колірний баланс) 

(Highlights) подано на рис. 12.32. 
 

 
 

Рис. 12.32. Налаштування коригуючого шару, Highlights 

 

Виконайте зведення всіх шарів Layer > Flatten Image (Шар – Вико-

нати зведення), потім застосуйте фільтр Filter > Noise > Reduce Noise 

(Фільтр – Шум – Зменшити шум), цим ви збільшите різкість ефекту і змен-

шите колірний шум кола (рис. 12.33). 
 

 
 

Рис. 12.33. Налаштування фільтра шуму 
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Збережіть отриманий результат (рис. 12.34). 

 

 
 

Рис. 12.34. Результат створення ефекту 

 

2) Створення барвистого ефекту (рис. 12.35). 

 

 
 

Рис. 12.35. Результат створення барвистого ефекту 
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Для роботи знадобляться пензлі (файл dirt – brushes.zip) і фотог-

рафія моделі (файл Модель.jpg), які необхідно взяти в папці з матеріа-

лами до даної лабораторної роботи. 

Крок 1. Створіть новий документ розміром 880х1200 рх, колір фону – 

білий. Створіть новий шар "Текстура" і пензлем з архіву з непрозорістю 

(Opacity) 40 % надайте фону ефект бруду. 

Пам’ятайте, що краще використовувати декілька видів пензлів при 

малюванні. 

Після цього продублюйте цей шар і за допомогою "Вільної транс-

формації" (Ctrl + T) і Перспективи (Perspective) і розмістіть новий шар, як 

показано на рис. 12.36. 

 

 

 

Рис. 12.36. Створення перспективи шару 

 

Зменшіть непрозорість (Opacity) цього шару до 50 %. 

Крок 2. Відкрийте файл з моделлю, виріжте її з фону будь-яким 

зручним для вас способом і розмістіть в основному файлі. Шар з дівчи-

ною назвіть "Модель" (рис. 12.37). 
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Рис. 12.37. Шар "Модель" в основному файлі 

 

Додайте два коригувальних шара. Переконайтеся, що при їх дода-

ванні у вас стоїть галочка на "Use Previous Layer as Clipping Mask" / "Ви-

користовувати попередній шар для створення відсічної маски". 

Коригувальний шар "Рівні" (Levels) показано на рис. 12.38. 

 

 
 

Рис. 12.38. Коригувальний шар "Рівні" (Levels) 
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Маску до корегованого шару "Рівні" (Levels) показано на рис. 12.39. 

 

 

 

Рис. 12.39. Маска до корегованого шару "Рівні" (Levels) 

 

Коригувальний шар "Криві" (Curves) показано на рис. 12.40. 

 

 

 

Рис. 12.40. Коригувальний шар "Криві" (Curves) 

 

Маску до корегованого шару "Криві" (Curves) показано на рис. 12.41. 
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Рис. 12.41. Маска до корегованого шару "Криві" (Curves) 

 

Створіть маску до шару "Модель" і м’яким круглим пензлем зафар-

буйте в тих областях, що показані на рис. 12.42. 

 

 

 

Рис. 12.42. Створення маски до шару "Модель" 
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Режим накладення поставте на Soft Light (М’яке світло). 

Далі необхідно освітлити волосся. Для цього додайте ще одну мас-

ку і намалюйте білим круглим пензлем із жорсткістю 60 – 70 % лінії на 

волоссі (рис. 12.43). 

 

 

 

Рис. 12.43. Маска на волоссі 

 

Режим накладення поставте на "Перекриття" (Overlay), непрозо-

рість зменшіть до 80 %. 

Крок 3. Створіть новий шар "Лінії" і використовуйте Pen Tool (Перо) 

(Р) для того, щоб намалювати лінію (рис. 12.44). 

 

 
 

Рис. 12.44. Створення ліній за допомогою інструменту Pen Tool 
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Виберіть пензель з розміром 13 рх і жорсткістю 100 % (рис. 12.45). 

 

 
 

Рис. 12.45. Вибір пензля 

 

Перейдіть знову на інструмент "Перо", натисніть правою кнопкою  

на лінії і виберіть "Виконати обведення" (Stroke Path). Поставте галочку 

на Simulate Pressure (Імітувати натиск), як подано на рис. 12.46. 

 

 
 

Рис. 12.46. Вибір режиму Simulate Pressure (Імітувати натиск) 

 

Результат показано на рис. 12.47. 

 

 
 

Рис. 12.47. Результат створення лінії за допомогою заданого пензля 
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Продублюйте кілька разів шар з лінією, поверніть і зменшіть розмір 

одержаних шарів (рис. 12.48). 

 

 
 

Рис. 12.48. Результат дублювання і трансформації ліній 

 

Крок 4. Тепер перейдіть до створення широких ліній. Для цього 

створіть новий документ і за допомогою Rectangular Marquee (Прямокут-

не виділення) (М) намалюйте прямокутник (рис. 12.49). 

 

 
 

Рис. 12.49. Прямокутне виділення 
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Залийте це виділення кольором за вашим смаком. 

Потім натисніть CTRL + T, далі натисніть правою кнопкою на прямо-

кутнику і виберіть Distort (Спотворення), як показано на рис. 12.50. 

 

 
 

Рис. 12.50. Вибір деформації 

 

Утримуючи клавішу Alt, "спотворте" зображення, як показано на 

рис. 12.51. 

 

 
 

Рис. 12.51. Деформація прямокутника 

 

Тепер кілька разів продублюйте шари, залийте різними кольорами  

і змініть розміри (рис. 12.52). 

 

 
 

Рис. 12.52. Результат створення різнокольорових прямокутників 
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За допомогою натискання CTRL + E злийте шари. Тепер натисніть 

CTRL + T, потім натисніть правою кнопкою на фігурі, яка у вас вийшла,  

і виберіть Warp (Деформація). 

Деформуйте фігуру так, як показано на рис. 12.53. 

 

 
 

Рис. 12.53. Деформація фігури 

 

Помістіть деформовану фігуру в основний документ (рис. 12.54). 

 

 
 

Рис. 12.54. Кольорові лінії в основному документі 
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Дублювання цих ліній і деформація надає ефект глибини зобра-

ження (рис. 12.55). 

 

 

 

Рис. 12.55. Створення ефекту глибини зображення шляхом  

дублювання і деформації різнокольорових ліній 

 

Додайте ще кілька абстрактних ліній на тлі зображення (не обов’яз-

ково). 

Крок 5. Тепер ви можете додати загальні тіні і відблиски до вашого 

зображення. Створіть новий шар вище всіх попередніх і, використовуючи 

м’який круглий пензель чорного і білого кольорів, намалюйте, як показа-

но на рис. 12.56. 
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Рис. 12.56. Заготовки для відблисків і тіней 

 

Самостійно виберіть режим змішування шару з відблисками і тінню 

таким чином, щоб результат вийшов, як на рис. 12.57. 

 

 
 

Рис. 12.57. Зображення зі світлом і тінню 
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Крок 6. Додайте кілька нюансів до вашого зображення. Продублюй-

те всі шари (крім фонового) і додайте фільтр Smart Sharpen "Розумна рі-

зкість" (рис. 12.58). 

 

 

 

Рис. 12.58. Додавання різкості зображення 

 

Далі застосуйте фільтр Angled Strokes (Похилі штрихи), перед цим 

продублюйте фоновий шар ще раз (рис. 12.59). 
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Рис. 12.59. Параметри фільтру Angled Strokes 

 

Зменшіть непрозорість цього шару до 40 % і ви побачите, який ви-

йшов ефект в області лівої ноги і грудей (рис. 12.60). 

 

 

 

Рис. 12.60. Результат застосування фільтра Angled Strokes  

 

Потім додайте коригувальний шар "Кольоровий баланс" (рис. 12.61). 
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Рис. 12.61. Налаштування шару Кольоровий баланс 

 

Збережіть отриманий результат (рис. 12.62). 

 

 
 

Рис. 12.62. Результат створення композиції 
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Завдання 

1. Дотримуючись методичних рекомендацій щодо створення пенз-

лів в Adobe Photoshop, створіть не менше п’яти власних пензлів у рамках 

однієї тематики на ваш вибір. Виконайте ілюстрацію на цю ж тему тільки 

пензлями. Ілюстрація повинна відповідати законам композиції та дизайну 

(повинні бути дотриманими баланс, колірні поєднання і т. д.). Результат 

збережіть у форматі jpg. 

2. Виконайте методичні рекомендації щодо створення візуальних 

ефектів в Adobe Photoshop. При створенні кольорового ефекту візьміть 

власну фотографію в якості моделі. Результати збережіть у форматі jpg. 

3. В якості результату виконання даної лабораторної роботи по-

трібно здати викладачеві 6 файлів: "вихідник" (файл у форматі psd)  

з композицією, виконаною пензлями; кінцевий результат створення цієї 

композиції (файл у форматі jpg); вихідні коди результатів виконання ме-

тодичних рекомендацій щодо створення візуальних ефектів (файл у фор-

маті psd); кінцеві результати створення візуальних ефектів (файл у фор-

маті jpg). 

 

 

Лабораторна робота № 13 

Тема "Створення іконок до мультимедійного видання" 

 

Мета роботи – навчитися створювати елементи навігації для елект-

ронних видань за допомогою програм створення і обробки растрової 

графіки. 

Дана лабораторна робота сприяє напрацюванню наступних компе-

тентностей у відповідності до Національної рамки кваліфікації: 

Знання: 

техніки перетворення намальованих та пластилінових ілюстрацій  

у цифрову форму;  

особливості використання апаратних засобів для оцифрування 

ілюстрацій;  

особливості ретушування оцифрованих ілюстрацій;  

особливості використання інструментів та фільтрів для обробки 

цифрових ілюстрацій. 
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Уміння: 

перетворювати намальовані та пластилінові ілюстрації у цифрову 

форму; 

створювати, редагувати і застосовувати векторні об’єкти для отри-

мання фігур; 

створювати піктограми для електронних навчальних видань; 

ретушувати оцифровані ілюстрації;  

використовувати інструменти та фільтри для обробки цифрових 

ілюстрацій. 

Комунікації: 

рекомендації авторам щодо ретушування відцифрованих ілюстрацій; 

спільно з автором обговорювати необхідність ретушування оциф-

рованих ілюстрацій;  

обговорити з дизайнером можливість використання апаратних за-

собів для оцифрування ілюстрацій. 

Автономність і відповідальність: 

приймати рішення про досягнення цілей при ретушування відциф-

рованих ілюстрацій; 

пошук нових підходів до ретушування відцифрованих ілюстрацій. 

 

Хід роботи 

 

Частина 1. Створення кнопки 

 

1. У Adobe Photoshop створіть новий документ розміром 400 x 110 рх. 

Виберіть інструмент "Прямокутник" із закругленими краями (Rounded 

Rectangle Tool), задайте радіус заокруглення кутів 12 px і намалюйте 

прямокутник, як показано на рис. 13.1. 

 

 
 

Рис. 13.1. Прямокутник із закругленими краями 
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2. Перейдіть у меню Стилів шару (Layer Style – Blending Options) 

і застосуйте ці стилі, як показано на рис. 2 (колір тіні # 6298d6; кольори 

градієнта # 6298d6 і # 81b9e1). 

 

 
 

Рис. 13.2. Внутрішня тінь 

 

На рис. 13.3 подано діалогове вікно накладення градієнта. 

 

 
 

Рис. 13.3. Накладення градієнта 

http://www.egraphic.ru/uploads/1245876108_4.jpg
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3. Зробіть виділення шару кнопкою (CTRL + Click) і застосуйте "Стис-

нення" (Modify > Contract), введіть значення 5 рх (рис. 13.4). 

 

 
 

Рис. 13.4. Модифікація виділення 

 

4. Створіть новий шар (Create New Layer) і залийте виділення ін-

струментом "Градієнт" (Gradient Tool), колір – від білого до прозорого, 

зробіть заливку зверху вниз (рис. 13.5). 

 

 
 

Рис. 13.5. Результат заливки виділенням градієнтом 

 

5. Інструментом "Перо" (Pen Tool) зробіть виділення нижньої поло-

вини градієнта і видаліть цю область, щоб отримати результат, як пока-

зано на рис. 13.6. 

 

 
 

Рис. 13.6. Результат видалення нижньої половини градієнта 

 

6. Інструментом "Горизонтальний текст" (Horizontal Type Tool) ство-

ріть довільний текстовий напис білого кольору (рис. 13.7). 
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Рис. 13.7. Текстовий напис на кнопці 

 

7. До шару з текстом застосуйте стиль "Відкидання тіні" (Layer Style > 

Drop Shadow), як подано на рис. 13.8. 

 

 
 

Рис. 13.8. Налаштування стилю "Відкидання тіні" 

 

Результат застосування стилю "Відкидання стилю" до кнопки пода-

но на рис. 13.9. 

 

 
 

Рис. 13.9. Результат застосування стилю "Відкидання тіні" 

 

8. Зробіть копію шару з кнопкою, помістіть копію під оригінальною 

кнопкою на полотні і зітріть нижню кнопку, як показано на рис. 13.10. 
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Рис. 13.10. Відображення кнопки на поверхні 

 

9. Можете завантажити фігуру і вставити її у вашу кнопку (рис. 13.11). 
 

 
 

Рис. 13.11. Кнопка з декоративним елементом 

 

Частина 2. Створення іконки 

Створимо іконку, подану на рис. 13.12. 

 
Рис. 13.12. Готова іконка 

 

1. Створіть новий документ розміром 283 x 152, потім візьміть 

Elipse Tool і намалюйте коло (колір f1f1f1). Назвіть цей шар "Grеy 

Circle" (рис. 13.13). 

 

 
 

Рис. 13.13. Коло на шарі "Grey Circle" 
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2. За допомогою Elipse Tool знову намалюйте коло (колір 3f84e2). 

Назвіть цей шар "Blue Circle". 

 
 

Рис. 13.14. Коло на шарі "Blue Circle" 

 

3. Утримуючи Ctrl, натисніть на зображенні шара "Blue Circle", щоб ство-

рити виділення. Тепер викличте Selection > Modify > Contract = 1 (рис. 13.15). 

 
 

Рис. 13.15. Уточнення області виділення 

 

4. Тепер поверніться до шару "Grey Circle" і растерізуйте його:  

Layer > Rasterize > Shape. Потім зайдіть в Edit > Cut, щоб прибрати центр 

шару "Grey Circle". Перетягніть шар "Blue Circle" так, щоб він був під ша-

ром "Grey Circle" в палітрі шарів. 

5. Виберіть шар "Grey Circle" і застосуйте до нього наступні налаш-

тування: Blending Options > Inner Glow (рис. 13.16). 
 

 
 

Рис. 13.16. Налаштування Blending Options > Inner Glow 
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Виберіть шар "Grey Circle" і застосуйте до нього налаштування 

Blending Options > Bevel and Emboss (рис. 13.17). 
 

 
 

Рис. 13.17. Налаштування Blending Options > Bevel and Emboss 
 

Виберіть шар "Grey Circle" і застосуйте до нього налаштування 

Blending Options > Gradient Overlay (рис. 13.18). 
 

 
 

Рис. 13.18. Налаштування Blending Options > Gradient Overlay 

 

Налаштування градієнта подано на рис. 13.19. 
 

 
 

Рис. 13.19. Налаштування градієнта 
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6. Результат повинен бути схожим на рис. 13.20. 

 

 
 

Рис. 13.20. Результат налаштування ефектів шару 

 

7. Виберіть шар "Blue Circle" і застосуйте до нього налаштування, 

показані на рис. 13.21. 

 

 
 

Рис. 13.21. Налаштування Blending Options > Inner Shadow 

 

Виберіть шар "Blue Circle" і застосуйте до нього налаштування 

Blending Options > Satin, показані на рис. 13.22. 

 

 
 

Рис. 13.22. Налаштування Blending Options > Satin 
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Виберіть шар "Blue Circle" і застосуйте до нього налаштування 

Blending Options > Gradient Overlay, показані на рис. 13.23. 
 

 
 

Рис. 13.23. Налаштування Blending Options > Gradient Overlay 

 

Виберіть шар "Blue Circle" і застосуйте до нього налаштування гра-

дієнта, як показано на рис. 13.24. 
 

 
 

Рис. 13.24. Налаштування градієнта 

 

8. Результат повинен вийти схожим на рис. 13.25. 

 

 
 

Рис. 13.25. Результат виконання налаштувань 

 

9. Візьміть інструмент Rounded Rectangle Tool. Намалюйте прямо-

кутник, як подано на рис. 13.26 (радіус = 3 px, колір 3f84e2). Назвіть цей 

шар "Bell". 

 
 

Рис. 13.26. Заготівля для дзвінка будильника 
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10. До шару "Bell" застосуйте налаштування, як показано на рис. 13.27. 

 

 
 

Рис. 13.27. Налаштування Blending Options > Drop Shadow 

 

До шару "Bell" застосуйте налаштування Inner Shadow, як показано 

на рис. 13.28. 

 

 
 

Рис. 13.28. Налаштування Blending Options > Inner Shadow 

 

До шару "Bell" застосуйте налаштування Inner Glow, як показано на 

рис. 13.29. 
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Рис. 13.29. Налаштування Blending Options > Inner Glow 
 

До шару "Bell" застосуйте налаштування Satin, як показано на рис. 13.30. 
 

 
 

Рис. 13.30. Налаштування Blending Options > Satin 
 

До шару "Bell" застосуйте налаштування Gradient Overlay, як пока-

зано на рис. 13.31. 

 
 

Рис. 13.31. Налаштування Blending Options > Gradient Overlay 
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До шару "Bell" застосуйте налаштування градієнта, як показано на 

рис. 13.32. 

 

 
 

Рис. 13.32. Налаштування градієнта 

 

11. Результат повинен бути схожим на рис. 13.33. 

 

 
 

Рис. 13.33. Результат виконання налаштувань 

 

12. Згідно з рис. 13.34, повинно вийти два дзвіночка, розміщених під 

кутом. Щоб повернути шар "Bell", зайдіть у головне меню: Edit > Free 

Transform. Утримуючи Shift, поверніть шар "Bell", поки він не досягне зна-

чення 30 градусів на панелі налаштувань. Скопіюйте шар "Bell" (CTRL +  

+ J) і зайдіть в головне меню: Edit > Transform > Flip Horizontally. Перемі-

стіть дзвіночки на потрібне місце і розмістіть під шаром "Grey Circle". 

 

 
 

Рис. 13.34. Правильне розташування дзвіночків 

 

13. Потім візьміть Elipse Tool. Намалюйте коло (колір 3f84e2). На-

звіть цей шар "Clock Legs". Розташуйте його під шаром "Grey Circle". 

Тепер потрібно пересунути нижню точку шару "Clock Legs". Щоб це 

зробити, візьміть інструмент Direct Selection Tool і виділіть нижню точку, 



152 

як показано на рис. 13.35а. Потім, використовуючи стрілку вгору і клавішу 

Shift, перемістіть точку вгору на 3 кроки (див. рис. 13.35б та рис. 13.35в). 

Потім пересуньте бічні точки так само, утримуючи клавішу Shift (рис. 13.35в). 

 

     а       б 

в 

 

Рис. 13.35. Процес створення підставки будильника 

 

14. До шару "Clock Legs" застосуйте налаштування Drop Shadow, як 

показано на рис. 13.36.  

 

 
 

Рис. 13.36. Налаштування Blending Options > Drop Shadow 
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До шару "Clock Legs" застосуйте налаштування Inner Shadow, як 

показано на рис. 13.37. 

 

 
 

Рис. 13.37. Налаштування Blending Options > Inner Shadow 

 

До шару "Clock Legs" застосуйте налаштування Inner Glow, як пока-

зано на рис. 13.38. 
 

 
 

Рис. 13.38. Налаштування Blending Options > Inner Glow 

 

До шару "Clock Legs" застосуйте налаштування Satin, як показано 

на рис. 13.39. 
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Рис. 13.39. Налаштування Blending Options > Satin 

 

Результат показано на рис. 13.40. 

 

 
Рис. 13.40. Результат виконання налаштувань 

 

15. Візьміть Pen Tool і намалюйте стрілки годинника. Потім додайте 

тіні: правий клік на стрілках і Blending Options > Drop Shadow > Angle: 

113; Distance: 1; Size: 2. 

16. Візьміть Elipse Tool. Намалюйте чорне коло. Назвіть цей шар 

"Shadow". Помістіть його під шаром "Clock Legs" (рис. 13.41). 

 

 
 

Рис. 13.41. Заготівля для тіні під годинником 

 

17. Виберіть шар "Clock Legs" і зайдіть у Blending Options (рис. 13.42). 
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Рис. 13.42. Налаштування Blending Options 

 

Виберіть шар "Clock Legs" і зайдіть у Blending Options > Outer Glow 

(рис. 13.43). 

 

 
 

Рис. 13.43. Налаштування Blending Options > Outer Glow 

 

Результат повинен вийти схожим на рис. 13.44. 
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Рис. 13.44. Результат створення тіні під годинником 

 

Можна додати відблиск на скло годин, щоб зробити їх трохи реаліс-

тичніше (рис. 13.45). 

 

 
 

Рис. 13.45. Відблиск на склі годинника 

 

Завдання 

1. Виконайте методичні рекомендації до даної лабораторної робо-

ти. Залиште результати у форматі jpg. Для фінального етапу першої час-

тини методичних рекомендацій можна використовувати одну або декіль-

ка форм, що перебувають у папці, виданої викладачем. 

2. Створіть іконку, що зображає будь-який предмет побуту, в техні-

ці, яка описана в другій частині методичних рекомендацій. Збережіть ре-

зультат у форматі jpg. 

3. У результаті виконання даної лабораторної роботи має бути зда-

но шість файлів – три вихідних у форматі psd (кнопка і дві іконки) і три 

фінальних у форматі jpg. 
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